






[image: PDFHALL.COM]






Menu





	 maison
	 Ajouter le document
	 Signe
	 Créer un compte







































mikroC Users Manual - SITE WEB UPS Thierry Perisse

The PDF-edition of the ... Projects. 22. Source Files. 24. Search Paths. 24. Managing Source Files. 25 ..... Consult the Error Messages for more information about errors recognized by the ... If there is a new user code to be downloaded, the ... mikroC organizes applications into projects, consisting of a single project file. 

















 Télécharger le PDF 






 2MB taille
 12 téléchargements
 339 vues






 commentaire





 Report
























mikroElektronika C Compiler for Microchip PIC microcontrollers



mikroC Making it simple



mikro



User’s manual



Development tools - Books - Compilers www.mikroe.com



ICD



Develop your applications quickly and easily with the world's most intuitive C compiler for PIC Microcontrollers (families PIC12, PIC16, and PIC18).



IN-CIRCUIT



Highly sophisticated IDE provides the power you need with the simplicity of a Windows based point-and-click environment.



SUPPORTED from V6.0



With useful implemented tools, many practical code examples, broad set of built-in routines, and a comprehensive Help, mikroC makes a fast and reliable tool, which can satisfy needs of experienced engineers and beginners alike.



DEBUGGER
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DISCLAIMER: mikroC and this manual are owned by mikroElektronika and are protected by copyright law and international copyright treaty. Therefore, you should treat this manual like any other copyrighted material (e.g., a book). The manual and the compiler may not be copied, partially or as a whole without the written consent from the mikroEelktronika. The PDF-edition of the manual can be printed for private or local use, but not for distribution. Modifying the manual or the compiler is strictly prohibited.



HIGH RISK ACTIVITIES The mikroC compiler is not fault-tolerant and is not designed, manufactured or intended for use or resale as on-line control equipment in hazardous environments requiring fail-safe performance, such as in the operation of nuclear facilities, aircraft navigation or communication systems, air traffic control, direct life support machines, or weapons systems, in which the failure of the Software could lead directly to death, personal injury, or severe physical or environmental damage ("High Risk Activities"). mikroElektronika and its suppliers specifically disclaim any express or implied warranty of fitness for High Risk Activities. LICENSE AGREEMENT: By using the mikroC compiler, you agree to the terms of this agreement. Only one person may use licensed version of mikroC compiler at a time. Copyright © mikroElektronika 2003 - 2006. This manual covers mikroC version 6.2.0.1 and the related topics. Newer versions may contain changes without prior notice. COMPILER BUG REPORTS: The compiler has been carefully tested and debugged. It is, however, not possible to guarantee a 100 % error free product. If you would like to report a bug, please contact us at the address [email protected]. Please include next information in your bug report: - Your operating system - Version of mikroC - Code sample - Description of a bug CONTACT US: mikroElektronika Voice: + 381 (11) 30 66 377, + 381 (11) 30 66 378 Fax: + 381 (11) 30 66 379 Web: www.mikroe.com E-mail: [email protected]



PIC, PICmicro and MPLAB is a Registered trademark of Microchip company. Windows is a Registered trademark of Microsoft Corp. All other trade and/or services marks are the property of the respective owners.
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mikroC IDE QUICK OVERVIEW mikroC is a powerful, feature rich development tool for PICmicros. It is designed to provide the customer with the easiest possible solution for developing applications for embedded systems, without compromising performance or control. PIC and C fit together well: PIC is the most popular 8-bit chip in the world, used in a wide variety of applications, and C, prized for its efficiency, is the natural choice for developing embedded systems. mikroC provides a successful match featuring highly advanced IDE, ANSI compliant compiler, broad set of hardware libraries, comprehensive documentation, and plenty of ready-to-run examples.
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Watch Window



Code Explorer



Code Editor Project Summary Error Window Code Assistant



mikroC allows you to quickly develop and deploy complex applications: - Write your C source code using the highly advanced Code Editor - Use the included mikroC libraries to dramatically speed up the development: data acquisition, memory, displays, conversions, communications… - Monitor your program structure, variables, and functions in the Code Explorer. Generate commented, human-readable assembly, and standard HEX compatible with all programmers. - Inspect program flow and debug executable logic with the integrated Debugger. Get detailed reports and graphs on code statistics, assembly listing, calling tree… - We have provided plenty of examples for you to expand, develop, and use as building bricks in your projects.
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CODE EDITOR The Code Editor is an advanced text editor fashioned to satisfy the needs of professionals. General code editing is same as working with any standard text-editor, including familiar Copy, Paste, and Undo actions, common for Windows environment. Advanced Editor features include: - Adjustable Syntax Highlighting - Code Assistant - Parameter Assistant - Code Templates (Auto Complete) - Auto Correct for common typos - Bookmarks and Goto Line You can customize these options from the Editor Settings dialog. To access the settings, choose Tools > Options from the drop-down menu, or click the Tools icon.



Tools Icon.
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Code Assistant [CTRL+SPACE] If you type a first few letter of a word and then press CTRL+SPACE, all the valid identifiers matching the letters you typed will be prompted in a floating panel (see the image). Now you can keep typing to narrow the choice, or you can select one from the list using the keyboard arrows and Enter.



Parameter Assistant [CTRL+SHIFT+SPACE] The Parameter Assistant will be automatically invoked when you open a parenthesis "(" or press CTRL+SHIFT+SPACE. If name of a valid function precedes the parenthesis, then the expected parameters will be prompted in a floating panel. As you type the actual parameter, the next expected parameter will become bold.



Code Template [CTR+J] You can insert the Code Template by typing the name of the template (for instance, whileb), then press CTRL+J, and the Code Editor will automatically generate the code. Or you can click a button from the Code toolbar and select a template from the list. You can add your own templates to the list. Just select Tools > Options from the drop-down menu, or click the Tools Icon from Settings Toolbar, and then select the Auto Complete Tab. Here you can enter the appropriate keyword, description, and code of your template.
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Auto Correct The Auto Correct feature corrects common typing mistakes. To access the list of recognized typos, select Tools > Options from the drop-down menu, or click the Tools Icon, and then select the Auto Correct Tab. You can also add your own preferences to the list.



Comment/Uncomment Comment / Uncomment Icon.



The Code Editor allows you to comment or uncomment selected block of code by a simple click of a mouse, using the Comment/Uncomment icons from the Code Toolbar.



Bookmarks Bookmarks make navigation through large code easier. CTRL+ : Go to a bookmark CTRL+SHIFT+ : Set a bookmark



Goto Line Goto Line option makes navigation through large code easier. Select Search > Goto Line from the drop-down menu, or use the shortcut CTRL+G.
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CODE EXPLORER The Code Explorer is placed to the left of the main window by default, and gives a clear view of every declared item in the source code. You can jump to a declaration of any item by clicking it, or by clicking the Find Declaration icon. To expand or collapse treeview in Code Explorer, use the Collapse/Expand All icon.



Collapse/Expand All Icon.



Also, two more tabs are available in Code Explorer. QHelp Tab lists all the available built-in and library functions, for a quick reference. Double-clicking a routine in QHelp Tab opens the relevant Help topic. Keyboard Tab lists all the available keyboard shortcuts in mikroC.
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DEBUGGER The source-level Debugger is an integral component of mikroC development environment. It is designed to simulate operations of Microchip Technology's PICmicros and to assist users in debugging software written for these devices. Start Debugger



The Debugger simulates program flow and execution of instruction lines, but does not fully emulate PIC device behavior: it does not update timers, interrupt flags, etc. After you have successfully compiled your project, you can run the Debugger by selecting Run > Debug from the drop-down menu, or by clicking the Debug Icon . Starting the Debugger makes more options available: Step Into, Step Over, Run to Cursor, etc. Line that is to be executed is color highlighted. Debug [F9] Start the Debugger. Pause Debugger



Step Into



Step Over



Step Out



Run/Pause Debugger [F6] Run or pause the Debugger. Step Into [F7] Execute the current C (single– or multi–cycle) instruction, then halt. If the instruction is a routine call, enter the routine and halt at the first instruction following the call. Step Over [F8] Execute the current C (single– or multi–cycle) instruction, then halt. If the instruction is a routine call, skip it and halt at the first instruction following the call. Step Out [Ctrl+F8] Execute the current C (single– or multi–cycle) instruction, then halt. If the instruction is within a routine, execute the instruction and halt at the first instruction following the call. Run to cursor [F4] Executes all instructions between the current instruction and the cursor position.



Run to Cursor
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Toggle Breakpoint [F5] Toggle breakpoint at current cursor position. To view all the breakpoints, select Run > View Breakpoints from the drop-down menu. Double clicking an item in window list locates the breakpoint.



Watch Window Variables The Watch Window allows you to monitor program items while running your program. It displays variables and special function registers of PIC MCU, their addresses and values. Values are updated as you go through the simulation.



Double clicking one of the items opens a window in which you can assign a new value to the selected variable or register and change number formatting.
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Stopwatch Window The Stopwatch Window displays the current count of cycles/time since the last Debugger action. Stopwatch measures the execution time (number of cycles) from the moment the Debugger is started, and can be reset at any time. Delta represents the number of cycles between the previous instruction line (line where the Debugger action was performed) and the active instruction line (where the Debugger action landed). Note: You can change the clock in the Stopwatch Window; this will recalculate values for the newly specified frequency. Changing the clock in the Stopwatch Window does not affect the actual project settings – it only provides a simulation.
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View RAM Window Debugger View RAM Window is available from the drop-down menu, View › Debug Windows › View RAM. The View RAM Window displays the map of PIC’s RAM, with recently changed items colored red. You can change value of any field by double-clicking it.
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ERROR WINDOW In case that errors were encountered during compiling, the compiler will report them and won't generate a hex file. The Error Window will be prompted at the bottom of the main window by default. The Error Window is located under the message tab, and displays location and type of errors compiler has encountered. The compiler also reports warnings, but these do not affect the output; only errors can interefere with generation of hex.



Double click the message line in the Error Window to highlight the line where the error was encountered. Consult the Error Messages for more information about errors recognized by the compiler.
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STATISTICS



Statistics Icon.



After successful compilation, you can review statistics of your code. Select Project > View Statistics from the drop-down menu, or click the Statistics icon. There are six tab windows: Memory Usage Window Provides overview of RAM and ROM memory usage in form of histogram.



Procedures (Graph) Window Displays functions in form of histogram, according to their memory allotment.
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Procedures (Locations) Window Displays how functions are distributed in microcontroller’s memory.



Procedures (Details) Window Displays complete call tree, along with details for each function:



size, start and end address, calling frequency, return type, etc. page MikroElektronika: Development tools - Books - Compilers
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RAM Window Summarizes all GPR and SFR registers and their addresses. Also displays symbolic names of variables and their addresses.



ROM Window Lists op-codes and their addresses in form of a human readable hex code.
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INTEGRATED TOOLS USART Terminal mikroC includes the USART (Universal Synchronous Asynchronous Receiver Transmitter) communication terminal for RS232 communication. You can launch it from the drop-down menu Tools > Terminal or by clicking the Terminal icon.



ASCII Chart The ASCII Chart is a handy tool, particularly useful when working with LCD display. You can launch it from the drop-down menu Tools > ASCII chart.



page MikroElektronika: Development tools - Books - Compilers



15



mikroC mikroC - C Compiler for Microchip PIC microcontrollers



making it simple...



7 Segment Display Decoder The 7seg Display Decoder is a convenient visual panel which returns decimal/hex value for any viable combination you would like to display on 7seg. Click on the parts of 7 segment image to get the desired value in the edit boxes. You can launch it from the drop-down menu Tools > 7 Segment Display.



EEPROM Editor EEPROM Editor allows you to easily manage EEPROM of PIC microcontroller.
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mikroBootloader mikroBootloader can be used only with PICmicros that support flash write. 1. Load the PIC with the appropriate hex file using the conventional programming techniques (e.g. for PIC16F877A use p16f877a.hex). 2. Start mikroBootloader from the drop-down menu Tools > Bootoader. 3. Click on Setup Port and select the COM port that will be used. Make sure that BAUD is set to 9600 Kpbs. 4. Click on Open File and select the HEX file you would like to upload. 5. Since the bootcode in the PIC only gives the computer 4-5 sec to connect, you should reset the PIC and then click on the Connect button within 4-5 seconds. 6. The last line in then history window should now read “Connected”. 7. To start the upload, just click on the Start Bootloader button. 8. Your program will written to the PIC flash. Bootloader will report an errors that may occur. 9. Reset your PIC and start to execute. The boot code gives the computer 5 seconds to get connected to it. If not, it starts running the existing user code. If there is a new user code to be downloaded, the boot code receives and writes the data into program memory. The more common features a bootloader may have are listed below: - Code at the Reset location. - Code elsewhere in a small area of memory. - Checks to see if the user wants new user code to be loaded. - Starts execution of the user code if no new user code is to be loaded. - Receives new user code via a communication channel if code is to be loaded. - Programs the new user code into memory. Integrating User Code and Boot Code The boot code almost always uses the Reset location and some additional program memory. It is a simple piece of code that does not need to use interrupts; therefore, the user code can use the normal interrupt vector at 0x0004. The boot code must avoid using the interrupt vector, so it should have a program branch in the address range 0x0000 to 0x0003. The boot code must be programmed into memory using conventional programming techniques, and the configuration bits must be programmed at this time. The boot code is unable to access the configuration bits, since they are not mapped into the program memory space.
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KEYBOARD SHORTCUTS Below is the complete list of keyboard shortcuts available in mikroC IDE. You can also view keyboard shortcuts in Code Explorer window, tab Keyboard. IDE Shortcuts F1 CTRL+N CTRL+O CTRL+F9 CTRL+F11 CTRL+SHIFT+F5



Help New Unit Open Compile Code Explorer on/off View breakpoints



Basic Editor shortcuts F3 CTRL+A CTRL+C CTRL+F CTRL+P CTRL+R CTRL+S CTRL+SHIFT+S CTRL+V CTRL+X CTRL+Y CTRL+Z



Find, Find Next Select All Copy Find Print Replace Save unit Save As Paste Cut Redo Undo



Advanced Editor shortcuts CTRL+SPACE CTRL+SHIFT+SPACE CTRL+D CTRL+G CTRL+J CTRL+ CTRL+SHIFT+ CTRL+SHIFT+I CTRL+SHIFT+U CTRL+ALT+SELECT



Code Assistant Parameters Assistant Find declaration Goto line Insert Code Template Goto bookmark Set bookmark Indent selection Unindent selection Select columns
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Debugger Shortcuts F4 F5 F6 F7 F8 F9 CTRL+F2



Run to Cursor Toggle breakpoint Run/Pause Debugger Step into Step over Debug Reset
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Building Applications Creating applications in mikroC is easy and intuitive. Project Wizard allows you to set up your project in just few clicks: name your application, select chip, set flags, and get going. mikroC allows you to distribute your projects in as many files as you find appropriate. You can then share your mikroCompiled Libraries (.mcl files) with other developers without disclosing the source code. The best part is that you can use .mcl bundles created by mikroPascal or mikroBasic!
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PROJECTS mikroC organizes applications into projects, consisting of a single project file (extension .ppc) and one or more source files (extension .c). You can compile source files only if they are part of a project. Project file carries the following information: - project name and optional description, - target device, - device flags (config word) and device clock, - list of project source files with paths.



New Project New Project.



The easiest way to create project is by means of New Project Wizard, drop-down menu Project > New Project. Just fill the dialog with desired values (project name and description, location, device, clock, config word) and mikroC will create the appropriate project file. Also, an empty source file named after the project will be created by default.



Editing Project Edit Project.



Later, you can change project settings from drop-down menu Project > Edit Project. You can rename the project, modify its description, change chip, clock, config word, etc. To delete a project, simply delete the folder in which the project file is stored.



Add/Remove Files from Project Add to Project.



Remove from Project.



Project can contain any number of source files (extension .c). The list of relevant source files is stored in the project file (extension .ppc). To add source file to your project, select Project > Add to Project from drop-down menu. Each added source file must be self-contained, i.e. it must have all the necessary definitions after preprocessing. To remove file(s) from your project, select Project > Remove from Project from drop-down menu. Note: For inclusion of header files, use the preprocessor directive #include.



page



22



MikroElektronika: Development tools - Books - Compilers



mikroC making it simple...



mikroC - C Compiler for Microchip PIC microcontrollers



Extended functionality of the Project Files tab By using the Project Files' new features, you can reach all the output files (.lst, .asm) by a single click. You can also include in project the library files (.mcl), for libraries, either your own or compiler default, that are project-specific.



Libraries (.mcl) now have different, more compact format, compared to mikroC version 2. This, however, means that library formats are now incompatible. The users that are making transition from version 2 to 5, must re- build all their previously written libraries in order to use them in the new version. All the source code written and tested in previous versions should compile correctly on version 5.0, except for the asm{} blocks, which are commented in the asm section of help.
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SOURCE FILES Source files containing C code should have the extension .c. List of source files relevant for the application is stored in project file with extension .ppc, along with other project information. You can compile source files only if they are part of a project. Use the preprocessor directive #include to include headers. Do not rely on preprocessor to include other source files — see Projects for more information.



Search Paths Paths for source files (.c) You can specify your own custom search paths. This can be configured by selecting Tools > Options from drop-down menu and then tab window Advanced. In project settings, you can specify either absolute or relative path to the source file. If you specify a relative path, mikroC will look for the file in following locations, in this particular order: 1. the project folder (folder which contains the project file .ppc), 2. your custom search paths, 3. mikroC installation folder > “uses” folder.
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Paths for Header Files (.h) Header files are included by means of preprocessor directive #include. If you place an explicit path to the header file in preprocessor directive, only that location will be searched. You can specify your own custom search paths: select Tools › Options from the drop-down menu and then select Search Path. In project settings, you can specify either absolute or relative path to the header. If you specify a relative path, mikroC will look for the file in following locations, in this particular order: 1. the project folder (folder which contains the project file .ppc), 2. mikroC installation folder > “include” folder, 3. your custom search paths.



Managing Source Files Creating a new source file New File.



To create a new source file, do the following: Select File > New from drop-down menu, or press CTRL+N, or click the New File icon. A new tab will open, named “Untitled1”. This is your new source file. Select File > Save As from drop-down menu to name it the way you want. If you have used New Project Wizard, an empty source file, named after the project with extension .c, is created automatically. mikroC does not require you to have source file named same as the project, it’s just a matter of convenience.
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Opening an Existing File



Open File Icon.



Select File > Open from drop-down menu, or press CTRL+O, or click the Open File icon. The Select Input File dialog opens. In the dialog, browse to the location of the file you want to open and select it. Click the Open button. The selected file is displayed in its own tab. If the selected file is already open, its current Editor tab will become active. Printing an Open File



Print File Icon.



Make sure that window containing the file you want to print is the active window. Select File > Print from drop-down menu, or press CTRL+P, or click the Print icon. In the Print Preview Window, set the desired layout of the document and click the OK button. The file will be printed on the selected printer. Saving File



Save File Icon.



Make sure that window containing the file you want to save is the active window. Select File > Save from drop-down menu, or press CTRL+S, or click the Save icon. The file will be saved under the name on its window. Saving File Under a Different Name



Save File As.



Make sure that window containing the file you want to save is the active window. Select File > Save As from drop-down menu, or press SHIFT+CTRL+S. The New File Name dialog will be displayed. In the dialog, browse to the folder where you want to save the file. In the File Name field, modify the name of the file you want to save. Click the Save button. Closing a File



Close File.



Make sure that tab containing the file you want to close is the active tab. Select File > Close from drop-down menu, or right click the tab of the file you want to close in Code Editor. If the file has been changed since it was last saved, you will be prompted to save your changes.
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COMPILATION



Compile Icon.



When you have created the project and written the source code, you will want to compile it. Select Project > Build from drop-down menu, or click Build Icon, or simply hit CTRL+F9. Progress bar will appear to inform you about the status of compiling. If there are errors, you will be notified in the Error Window. If no errors are encountered, mikroC will generate output files.



Output Files Upon successful compilation, mikroC will generate output files in the project folder (folder which contains the project file .ppc). Output files are summarized below: Intel HEX file (.hex) Intel style hex records. Use this file to program PIC MCU. Binary mikro Compiled Library (.mcl) Binary distribution of application that can be included in other projects. List File (.lst) Overview of PIC memory allotment: instruction addresses, registers, routines, etc. Assembler File (.asm) Human readable assembly with symbolic names, extracted from the List File.



Assembly View



View Assembly Icon.



After compiling your program in mikroC, you can click View Assembly Icon or select Project › View Assembly from drop-down menu to review generated assembly code (.asm file) in a new tab window. Assembly is human readable with symbolic names. All physical addresses and other information can be found in Statistics or in list file (.lst). If the program is not compiled and there is no assembly file, starting this option will compile your code and then display assembly.
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ERROR MESSAGES Error Messages -



Specifier needed Invalid declarator Expected '(' or identifier Integer const expected Array dimension must be greater then 0 Local objects cannot be extern Declarator error Bad storage class Arguments cannot be of void type Specifer/qualifier list expected Address must be greater than 0 Identifier redefined case out of switch default label out of switch switch exp. must evaluate to integral type continue outside of loop break outside of loop or switch void func cannot return values Unreachable code Illegal expression with void Left operand must be pointer Function required Too many chars Undefined struct Nonexistent field Aggregate init error Incompatible types Identifier redefined Function definition not found Signature does not match Cannot generate code for expression Too many initializers of subaggregate Nonexistent subaggregate Stack Overflow: func call in complex expression Syntax Error: expected %s but %s found Array element cannot be function Function cannot return array
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Inconsistent storage class Inconsistent type %s tag redefined Illegal typecast %s is not a valid identifier Invalid statement Constant expression required Internal error %s Too many arguments Not enough parameters Invalid expresion Identifier expected, but %s found Operator [%s] not applicable to this operands [%s] Assigning to non-lvalue [%s] Cannot cast [%s] to [%s] Cannot assign [%s] to [%s] lvalue required Pointer required Argument is out of range Undeclared identifier [%s] in expression Too many initializers Cannot establish this baud rate at %s MHz clock



Compiler Warning Messages - Highly inefficent code: func call in complex expression - Inefficent code: func call in complex expression
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3



mikroC Language Reference C offers unmatched power and flexibility in programming microcontrollers. mikroC adds even more power with an array of libraries, specialized for PIC HW modules and communications. This chapter should help you learn or recollect C syntax, along with the specifics of programming PIC microcontrollers. If you are experienced in C programming, you will probably want to consult mikroC Specifics first.
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PIC SPECIFICS In order to get the most from your mikroC compiler, you should be familiar with certain aspects of PIC MCU. This knowledge is not essential, but it can provide you a better understanding of PICs’ capabilities and limitations, and their impact on the code writing.



Types Efficiency First of all, you should know that PIC’s ALU, which performs arithmetic operations, is optimized for working with bytes. Although mikroC is capable of handling very complex data types, PIC may choke on them, especially if you are working on some of the older models. This can dramatically increase the time needed for performing even simple operations. Universal advice is to use the smallest possible type in every situation. It applies to all programming in general, and doubly so with microcontrollers. When it comes down to calculus, not all PICmicros are of equal performance. For example, PIC16 family lacks hardware resources to multiply two bytes, so it is compensated by a software algorithm. On the other hand, PIC18 family has HW multiplier, and as a result, multiplication works considerably faster.



Nested Calls Limitations Nested call represents a function call within function body, either to itself (recursive calls) or to another function. Recursive function calls are supported by mikroC but with limitations. Recursive function calls can't contain any function parameters and local variables due to the PIC’s stack and memory limitations. mikroC limits the number of non-recursive nested calls to: - 8 calls for PIC12 family, - 8 calls for PIC16 family, - 31 calls for PIC18 family. Number of the allowed nested calls decreases by one if you use any of the following operators in the code: * / %. It further decreases if you use interrupts in the program. Number of decreases is specified by number of functions called from interrupt. Check functions reentrancy. If the allowed number of nested calls is exceeded, the compiler will report a stack overflow error. page
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PIC16 Specifics Breaking Through Pages In applications targeted at PIC16, no single routine should exceed one page (2,000 instructions). If routine does not fit within one page, linker will report an error. When confront with this problem, maybe you should rethink the design of your application – try breaking the particular routine into several chunks, etc. Limits of Indirect Approach Through FSR Pointers with PIC16 are “near”: they carry only the lower 8 bits of the address. Compiler will automatically clear the 9th bit upon startup, so that pointers will refer to banks 0 and 1. To access the objects in banks 3 or 4 via pointer, user should manually set the IRP, and restore it to zero after the operation. The stated rules apply to any indirect approach: arrays, structures and unions assignments, etc. Note: It is very important to take care of the IRP properly, if you plan to follow this approach. If you find this method to be inappropriate with too many variables, you might consider upgrading to PIC18. Note: If you have many variables in the code, try rearranging them with linker directive absolute. Variables that are approached only directly should be moved to banks 3 and 4 for increased efficiency.
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mikroC SPECIFICS ANSI Standard Issues Divergence from the ANSI C Standard mikroC diverges from the ANSI C standard in few areas. Some of these modifications are improvements intenteded to facilitate PIC programming, while others are result of PICmicro hardware limitations: Function recursion is supported with limitations because of no easily-usable stack and limited memory. See PIC Specifics. Pointers to variables and pointers to constants are not compatible, i.e. no assigning or comparison is possible between the two. mikroC treats identifiers declared with const qualifier as “true constants” (C++ style). This allows using const objects in places where ANSI C would expect a constant expression. If aiming at portability, use the traditional preprocessor defined constants. See Type Qualifiers and Constants. mikroC allows C++ style single–line comments using two adjacent slashes (//). Features under construction: anonymous structures and unions. Implementation-defined Behavior Certain sections of the ANSI standard have implementation-defined behavior. This means that the exact behavior of some C code can vary from compiler to compiler. Throughout the help are sections describing how the mikroC compiler behaves in such situations. The most notable specifics include: Floating-point Types, Storage Classes, and Bit Fields.
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Predefined Globals and Constants To facilitate PIC programming, mikroC implements a number of predefined globals and constants. All PIC SFR registers are implicitly declared as global variables of volatile unsigned short. These identifiers have external linkage, and are visible in the entire project. When creating a project, mikroC will include an appropriate .def file, containing declarations of available SFR and constants (such as T0IE, INTF, etc). Identifiers are all in uppercase, identical to nomenclature in Microchip datasheets. For the complete set of predefined globals and constants, look for “Defs” in your mikroC installation folder, or probe the Code Assistant for specific letters (Ctrl+Space in Editor).



Accessing Individual Bits mikroC allows you to access individual bits of 8-bit variables, types char and unsigned short. Simply use the direct member selector (.) with a variable, followed by one of identifiers F0, F1, … , F7. For example: // If RB0 is set, set RC0: if (PORTB.F0) PORTC.F0 = 1;



There is no need for any special declarations; this kind of selective access is an intrinsic feature of mikroC and can be used anywhere in the code. Identifiers F0–F7 are not case sensitive and have a specific namespace. Provided you are familiar with the particular chip, you can also access bits by name: INTCON.TMR0F = 0;



// Clear TMR0F



See Predefined Globals and Constants for more information on register/bit names. Note: If aiming at portability, avoid this style of accessing individual bits, and use the bit fields instead.
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Interrupts Interrupts can be easily handled by means of reserved word interrupt. mikroC implictly declares function interrupt which cannot be redeclared. Its prototype is: void interrupt(void);



Write your own definition (function body) to handle interrupts in your application. mikroC saves the following SFR on stack when entering interrupt and pops them back upon return: PIC12 and PIC16 family: W, STATUS, FSR, PCLATH PIC18 family: FSR (fast context is used to save WREG, STATUS, BSR) Note: mikroC does not support low priority interrupts; for PIC18 family, interrupts must be of high priority. Function Calls from Interrupt Calling functions from within the interrupt() routine is now possible. The compiler takes care about the registers being used, both in "interrupt" and in "main" thread, and performs "smart" context-switching between the two, saving only the registers that have been used in both threads.Check functions reentrancy. Here is a simple example of handling the interrupts from TMR0 (if no other interrupts are allowed): void interrupt() { counter++; TMR0 = 96; INTCON = $20; }//~



In case of multiple interrupts enabled, you need to test which of the interrupts occurred and then proceed with the appropriate code (interrupt handling).
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Linker Directives mikroC uses internal algorithm to distribute objects within memory. If you need to have variable or routine at specific predefined address, use linker directives absolute and org.



Directive absolute Directive absolute specifies the starting address in RAM for variable. If variable is multi-byte, higher bytes are stored at consecutive locations. Directive absolute is appended to the declaration of variable: int foo absolute 0x23; // Variable will occupy 2 bytes at addresses 0x23 and 0x24;



Be careful when using absolute directive, as you may overlap two variables by mistake. For example: char i absolute 0x33; // Variable i will occupy 1 byte at address 0x33 long jjjj absolute 0x30; // Variable will occupy 4 bytes at 0x30, 0x31, 0x32, 0x33, // so changing i changes jjjj highest byte at the same time



Directive org Directive org specifies the starting address of routine in ROM. Directive org is appended to the function definition. Directives applied to nondefining declarations will be ignored, with an appropriate warning issued by linker. Directive org cannot be applied to an interrupt routine. Here is a simple example: void func(char par) org 0x200 { // Function will start at address 0x200 nop; }
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Code Optimization Optimizer has been added to extend the compiler usability, cuts down the amount of code generated and speed-up its execution. Main features are:



Constant folding All expressions that can be evaluated in the compile time (i.e. are constant) are being replaced by their result. (3 + 5 -> 8); Constant propagation When a constant value is being assigned to certain variable, the compiler recognizes this and replaces the use of the variable in the code that follows by constant, as long as variable's value remains unchanged. Copy propagation The compiler recognizes that two variables have same value and eliminates one of them in the further code. Value numbering The compiler "recognize" if the two expressions yield the same result, and can therefore eliminate the entire computation for one of them. "Dead code" ellimination The code snippets that are not being used elsewhere in the programme do not affect the final result of the application. They are automatically being removed. Stack allocation Temporary registers ("Stacks") are being used more rationally, allowing for VERY complex expressions to be evaluated with minimum stack consumption. Local vars optimization No local variables are being used if their result does not affect some of the global or volatile variables. Better code generation and local optimization Code generation is more consistent, and much attention has been made to implement specific solutions for the code "building bricks" that further reduce output code size.
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Indirect Function Calls If the linker encounters an indirect function call (by a pointer to function), it assumes that any one of the functions, addresses of which were taken anywhere in the program, can be called at that point. Use the #pragma funcall directive to instruct the linker which functions can be called indirectly from the current function: #pragma funcall [, ,...] A corresponding pragma must be placed in the source module where function func_name is implemented. This module must also include declarations of all functions listed in the called_func list. All functions listed in the called_func list will be linked if function func_name is called in the code no meter whether any of them was called or not. Note: The #pragma funcall directive can help the linker to optimize function frame allocation in the compiled stack.
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LEXICAL ELEMENTS These topics provide a formal definition of the mikroC lexical elements. They describe the different categories of word-like units (tokens) recognized by a language. In the tokenizing phase of compilation, the source code file is parsed (that is, broken down) into tokens and whitespace. The tokens in mikroC are derived from a series of operations performed on your programs by the compiler and its built-in preprocessor. A mikroC program starts as a sequence of ASCII characters representing the source code, created by keystrokes using a suitable text editor (such as the mikroC editor). The basic program unit in mikroC is the file. This usually corresponds to a named file located in RAM or on disk and having the extension .c.



Whitespace Whitespace is the collective name given to spaces (blanks), horizontal and vertical tabs, newline characters, and comments. Whitespace can serve to indicate where tokens start and end, but beyond this function, any surplus whitespace is discarded. For example, the two sequences int i; float f;



and int i; float f;



are lexically equivalent and parse identically to give the six tokens. The ASCII characters representing whitespace can occur within literal strings, in which case they are protected from the normal parsing process (they remain as part of the string).
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Comments Comments are pieces of text used to annotate a program, and are technically another form of whitespace. Comments are for the programmer’s use only; they are stripped from the source text before parsing. There are two ways to delineate comments: the C method and the C++ method. Both are supported by mikroC. C comments C comment is any sequence of characters placed after the symbol pair /*. The comment terminates at the first occurrence of the pair */ following the initial /*. The entire sequence, including the four comment-delimiter symbols, is replaced by one space after macro expansion. In mikroC, int /* type */ i /* identifier */;



parses as: int i;



Note that mikroC does not support the nonportable token pasting strategy using /**/. For more on token pasting, refer to Preprocessor topics. C++ comments mikroC allows single-line comments using two adjacent slashes (//). The comment can start in any position, and extends until the next new line. The following code, int i; int j;



// this is a comment



parses as: int i; int j;



page MikroElektronika: Development tools - Books - Compilers



41



mikroC mikroC - C Compiler for Microchip PIC microcontrollers



making it simple...



mikro ICD (In-Circuit Debugger) mikro ICD is highly effective tool for Real-Time debugging on hardware level. ICD debugger enables you to execute a mikroC program on a host PIC microcontroller and view variable values, Special Function Registers (SFR), memory and EEPROM as the program is running.



If you have appropriate hardware and software for using mikro ICD then you have to upon completion of writing your program to choose between Release build Type or ICD Debug build type.



After you choose ICD Debug build type it's time to compile your project. After you have successfully compiled your project you must program PIC using F11 shortcut. After successful PIC programming you have to select mikro ICD by selecting Debugger › Select Debugger › mikro ICD Debugger from the dropdown menu.
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You can run the mikro ICD by selecting Run › Debug from the drop-down menu, or by clicking Debug Icon . Starting the Debugger makes more options available: Step Into, Step Over, Run to Cursor, etc. Line that is to be executed is color highlighted (blue by default). There is also notification about program execution and it can be found on Watch Window (yellow status bar). Note that some functions take time to execute, so running of program is indicated on Watch Window.
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mikro ICD Debugger Options



Name



Description



Function Key



Debug



Starts Debugger.



[F9]



Run/ Pause Debugger



Run or pause Debugger.



[F6]



Toggle Breakpoints



Toggle breakpoint at the current cursor position. To view all the breakpoints, select Run › View Breakpoints from the drop-down menu. Double clicking an item in window list locates the breakpoint.



[F5]



Run to cursor



Execute all instructions between the current instruction and the cursor position.



[F4]



Step Into



Execute the current C (single– or multi–cycle) instruction, then halt. If the instruction is a routine call, enter the routine and halt at the first instruction following the call.



[F7]



Step Over



Execute the current C (single– or multi–cycle) instruction, then halt. If the instruction is a routine call, skip it and halt at the first instruction following the call.



[F8]



Flush RAM



Flushes current PIC RAM. All variable values will be changed according to values from watch window.



N/A
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mikro ICD Debugger Example Here is a step by step mikro ICD Debugger Example. First you have to write a program. We will show how mikro ICD works using this example: void main(){ char text[21]="mikroElektronika"; char i=0; PORTD = 0x00; TRISD = 0x00; Lcd_Init(&PORTD); Lcd_Cmd(LCD_CLEAR); Lcd_Cmd(LCD_CURSOR_OFF); for(i=1;i=y) ? x : y; }



Here is a sample function which depends on side effects rather than return value: /* function converts Descartes coordinates (x,y) to polar coordinates (r,fi): */ #include void polar(double x, double y, double *r, double *fi) { *r = sqrt(x * x + y * y); *fi = (x == 0 && y == 0) ? 0 : atan2(y, x); return; /* this line can be omitted */ }



Function Reentrancy Limited reentrancy for functions is allowed. The functions that don't have their own function frame (no arguments and local variables) can be called both from the interrupt and the "main" thread. Functions that have input arguments and/or local variables can be called only from one of the before mentioned program threads. Check Indirect Function Calls.
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Function Calls A function is called with actual arguments placed in the same sequence as their matching formal parameters. Use a function-call operator (): function_name(expression_1, ... , expression_n)



Each expression in the function call is an actual argument. Number and types of actual arguments should match those of formal function parameters. If types disagree, implicit type conversions rules apply. Actual arguments can be of any complexity, but you should not depend on their order of evaluation, because it is not specified. Upon function call, all formal parameters are created as local objects initialized by values of actual arguments. Upon return from a function, temporary object is created in the place of the call, and it is initialized by the expression of return statement. This means that function call as an operand in complex expression is treated as the function result. If the function is without result (type void) or you don’t need the result, you can write the function call as a self-contained expression. In C, scalar parameters are always passed to function by value. A function can modify the values of its formal parameters, but this has no effect on the actual arguments in the calling routine. You can pass scalar object by the address by declaring a formal parameter to be a pointer. Then, use the indirection operator * to access the pointed object.



Argument Conversions When a function prototype has not been previously declared, mikroC converts integral arguments to a function call according to the integral widening (expansion) rules described in Standard Conversions. When a function prototype is in scope, mikroC converts the given argument to the type of the declared parameter as if by assignment.
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If a prototype is present, the number of arguments must match. The types need to be compatible only to the extent that an assignment can legally convert them. You can always use an explicit cast to convert an argument to a type that is acceptable to a function prototype. Note: If your function prototype does not match the actual function definition, mikroC will detect this if and only if that definition is in the same compilation unit as the prototype. If you create a library of routines with a corresponding header file of prototypes, consider including that header file when you compile the library, so that any discrepancies between the prototypes and the actual definitions will be caught. The compiler is also able to force arguments to the proper type. Suppose you have the following code: int limit = 32; char ch = 'A'; long res; extern long func(long par1, long par2); main() { //... res = func(limit, ch); }



// prototype



// function call



Since it has the function prototype for func, this program converts limit and ch to long, using the standard rules of assignment, before it places them on the stack for the call to func. Without the function prototype, limit and ch would have been placed on the stack as an integer and a character, respectively; in that case, the stack passed to func would not match in size or content what func was expecting, leading to problems.
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Ellipsis ('...') Operator An ellipsis ('...') consists of three successive periods with no whitespace intervening. You can use an ellipsis in the formal argument lists of function prototypes to indicate a variable number of arguments, or arguments with varying types. For example: void func (int n, char ch, ...);



This declaration indicates that func will be defined in such a way that calls must have at least two arguments, an int and a char, but can also have any number of additional arguments. Example: #include 



int addvararg(char a1,...){ va_list ap; char temp; va_start(ap,a1); while( temp = va_arg(ap,char)) a1 += temp; return a1; }



int res; void main() {



res = addvararg(1,2,3,4,5,0); res = addvararg(1,2,3,4,5,6,7,8,9,10,0); }//~!
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OPERATORS Operators are tokens that trigger some computation when applied to variables and other objects in an expression. mikroC recognizes following operators:



- Arithmetic Operators - Assignment Operators - Bitwise Operators - Logical Operators - Reference/Indirect Operators - Relational Operators - Structure Member Selectors



(see Pointer Arithmetic) (see Structure Member Access)



- Comma Operator , - Conditional Operator ? :



(see Comma Expressions)



- Array subscript operator [] - Function call operator ()



(see Arrays) (see Function Calls)



- sizeof Operator - Preprocessor Operators # and ##



(see Preprocessor Operators)



Operators Precedence and Associativity There are 15 precedence categories, some of which contain only one operator. Operators in the same category have equal precedence with each other. Table on the following page sums all mikroC operators. Where duplicates of operators appear in the table, the first occurrence is unary, the second binary. Each category has an associativity rule: left-to-right or right-to-left. In the absence of parentheses, these rules resolve the grouping of expressions with operators of equal precedence.
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Precedence



Operands



Operators



Associativity



15



2



()



14



1



! &



~ ++ (type)



13



2



*



/



12



2



+



-



11



2




 



left-to-right



>=



left-to-right



!=



*= ^=



/= |=



%= =



right-to-left left-to-right
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Arithmetic Operators Arithmetic operators are used to perform mathematical computations. They have numerical operands and return numerical results. Type char technically represents small integers, so char variables can used as operands in arithmetic operations. All of arithmetic operators associate from left to right.



Operator



Operation



Precedence



+



addition



12



-



subtraction



12



*



multiplication



13



/



division



13



%



returns the remainder of integer division (cannot be used with floating points)



13



+ (unary)



unary plus does not affect the operand



14



- (unary)



unary minus changes the sign of operand



14



++



increment adds one to the value of the operand



14



--



decrement subtracts one from the value of the operand



14



Note: Operator * is context sensitive and can also represent the pointer reference operator. See Pointers for more information.
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Binary Arithmetic Operators Division of two integers returns an integer, while remainder is simply truncated: /* for example: */ 7 / 4; // equals 1 7 * 3 / 4; // equals 5 /* but: */ 7. * 3./ 4.;



// equals 5.25 as we are working with floats



Remainder operand % works only with integers; sign of result is equal to the sign of first operand: /* for example: 9 % 3; // 7 % 3; // -7 % 3; //



*/ equals 0 equals 1 equals -1



We can use arithmetic operators for manipulating characters: 'A' + 32; 'G' - 'A' + 'a';



// equals 'a' (ASCII only) // equals 'g' (both ASCII and EBCDIC)



Unary Arithmetic Operators Unary operators ++ and -- are the only operators in C which can be either prefix (e.g. ++k, --k) or postfix (e.g. k++, k--). When used as prefix, operators ++ and -- (preincrement and predecrement) add or subtract one from the value of operand before the evaluation. When used as suffix, operators ++ and -- add or subtract one from the value of operand after the evaluation. For example: int j = 5; j = ++k; /* k = k + 1, j = k, which gives us j = 6, k = 6 */ int j = 5; j = k++; /* j = k, k = k + 1, which gives us j = 5, k = 6 */
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Relational Operators Use relational operators to test equality or inequality of expressions. If the expression evaluates to true, it returns 1; otherwise it returns 0. All relational operators associate from left to right. Relational Operators Overview Operator



Operation



Precedence



==



equal



9



!=



not equal



9



>



greater than



10




=



greater than or equal



10



= c - 1.0 / e



// i.e. (a + 5) >= (c - (1.0 / e))



Always bear in mind that relational operators return either 0 or 1. Consider the following examples: 8 == 13 > 5 14 > 5 < 3 a < b < 5



// returns 0: 8==(13>5), 8==1, 0 // returns 1: (14>5)= 'a' && c (B)) ? (A) : (B) // Let's call it: x = _MAX(a + b, c + d); /* Preprocessor will transform the previous line into: x = ((a + b) > (c + d)) ? (a + b) : (c + d) */



It is highly recommended to put parentheses around each of the arguments in macro body – this will avoid possible problems with operator precedence.



Undefining Macros You can undefine a macro using the #undef directive. #undef macro_identifier



Directive #undef detaches any previous token sequence from the macro_identifier; the macro definition has been forgotten, and the macro_identifier is undefined. No macro expansion occurs within #undef lines. The state of being defined or undefined is an important property of an identifier, regardless of the actual definition. The #ifdef and #ifndef conditional directives, used to test whether any identifier is currently defined or not, offer a flexible mechanism for controlling many aspects of a compilation. After a macro identifier has been undefined, it can be redefined with #define, using the same or a different token sequence.
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File Inclusion The preprocessor directive #include pulls in header files (extension .h) into the source code. Do not rely on preprocessor to include source files (extension .c) — see Projects for more information. The syntax of #include directive has two formats: #include #include "header_name"



The preprocessor removes the #include line and replaces it with the entire text of the header file at that point in the source code. The placement of the #include can therefore influence the scope and duration of any identifiers in the included file. The difference between the two formats lies in the searching algorithm employed in trying to locate the include file. If #include directive was used with the version, the search is made successively in each of the following locations, in this particular order: 1. mikroC installation folder > “include” folder, 2. your custom search paths. The "header_name" version specifies a user-supplied include file; mikroC will look for the header file in following locations, in this particular order: 1. the project folder (folder which contains the project file .ppc), 2. mikroC installation folder > “include” folder, 3. your custom search paths. Explicit Path If you place an explicit path in the header_name, only that directory will be searched. For example: #include "C:\my_files\test.h"
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Note: There is also a third version of #include directive, rarely used, which assumes that neither < nor " appears as the first non-whitespace character following #include: #include macro_identifier



It assumes a macro definition exists that will expand the macro identifier into a valid delimited header name with either of the or "header_name" formats.



Preprocessor Operators The # (pound sign) is a preprocessor directive when it occurs as the first nonwhitespace character on a line. Also, # and ## perform operator replacement and merging during the preprocessor scanning phase. Operator # In C preprocessor, character sequence enclosed by quotes is considered a token and its content is not analyzed. This means that macro names within quotes are not expanded. If you need an actual argument (the exact sequence of characters within quotes) as result of preprocessing, you can use the # operator in macro body. It can be placed in front of a formal macro argument in definition in order to convert the actual argument to a string after replacement. For example, let’s have macro LCD_PRINT for printing variable name and value on LCD: #define LCD_PRINT(val)



Lcd_Out_Cp(#val ": "); \ Lcd_Out_Cp(IntToStr(val));



(note the backslash as a line-continuation symbol)
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Now, the following code, LCD_PRINT(temp)



will be preprocessed to this: Lcd_Out_Cp("temp" ": "); Lcd_Out_Cp(IntToStr(temp));



Operator ## Operator ## is used for token pasting: you can paste (or merge) two tokens together by placing ## in between them (plus optional whitespace on either side). The preprocessor removes the whitespace and the ##, combining the separate tokens into one new token. This is commonly used for constructing identifiers. For example, we could define macro SPLICE for pasting two tokens into one identifier: #define SPLICE(x,y) x ## _ ## y



Now, the call SPLICE(cnt, 2) expands to identifier cnt_2. Note: mikroC does not support the older nonportable method of token pasting using (l/**/r).



Conditional Compilation Conditional compilation directives are typically used to make source programs easy to change and easy to compile in different execution environments. mikroC supports conditional compilation by replacing the appropriate source-code lines with a blank line. All conditional compilation directives must be completed in the source or include file in which they are begun.
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Directives #if, #elif, #else, and #endif The conditional directives #if, #elif, #else, and #endif work very similar to the common C conditional statements. If the expression you write after the #if has a nonzero value, the line group immediately following the #if directive is retained in the translation unit. Syntax is: #if constant_expression_1 [#elif constant_expression_2 ] ... [#elif constant_expression_n ] [#else ] #endif



Each #if directive in a source file must be matched by a closing #endif directive. Any number of #elif directives can appear between the #if and #endif directives, but at most one #else directive is allowed. The #else directive, if present, must be the last directive before #endif. The sections can be any program text that has meaning to the compiler or the preprocessor. The preprocessor selects a single section by evaluating the constant_expression following each #if or #elif directive until it finds a true (nonzero) constant expression. The constant_expressions are subject to macro expansion. If all occurrences of constant-expression are false, or if no #elif directives appear, the preprocessor selects the text block after the #else clause. If the #else clause is omitted and all instances of constant_expression in the #if block are false, no section is selected for further processing.
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Any processed section can contain further conditional clauses, nested to any depth. Each nested #else, #elif, or #endif directive belongs to the closest preceding #if directive. The net result of the preceding scenario is that only one code section (possibly empty) will be compiled. Directives #ifdef and #ifndef You can use the #ifdef and #ifndef directives anywhere #if can be used. The #ifdef and #ifndef conditional directives let you test whether an identifier is currently defined or not. The line #ifdef identifier



has exactly the same effect as #if 1 if identifier is currently defined, and the same effect as #if 0 if identifier is currently undefined. The other directive, #ifndef, tests true for the “not-defined” condition, producing the opposite results. The syntax thereafter follows that of the #if, #elif, #else, and #endif. An identifier defined as NULL is considered to be defined.
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mikroC Libraries mikroC provides a number of built-in and library routines which help you develop your application faster and easier. Libraries for ADC, CAN, USART, SPI, I2C, 1Wire, LCD, PWM, RS485, Serial Ethernet, Toshiba GLCD, Port Expander, Serial GLCD, numeric formatting, bit manipulation, and many other are included along with practical, ready-to-use code examples.
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BUILT-IN ROUTINES mikroC compiler provides a set of useful built-in utility functions. Built-in functions do not require any header files to be included; you can use them in any part of your project. Built-in routines are implemented as “inline”; i.e. code is generated in the place of the call, so the call doesn’t count against the nested call limit. The only exceptions are Vdelay_ms and Delay_Cyc, which are actual C routines. Note: Lo, Hi, Higher and Highest functions are not implemented in compiler any more. If you want to use these functions you must include built_in.h into your project. Lo Hi Higher Highest Delay_us Delay_ms Vdelay_ms Delay_Cyc Clock_Khz Clock_Mhz



Lo Prototype



unsigned short Lo(long number);



Returns



Returns the lowest 8 bits (byte) of number, bits 0..7.



Description



Function returns the lowest byte of number. Function does not interpret bit patterns of number – it merely returns 8 bits as found in register. This is an “inline” routine; code is generated in the place of the call, so the call doesn’t count against the nested call limit.



Requires



Arguments must be scalar type (i.e. Arithmetic Types and Pointers).



Example



d = 0x1AC30F4; tmp = Lo(d); // Equals 0xF4
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Hi Prototype



unsigned short Hi(long number);



Returns



Returns next to the lowest byte of number, bits 8..15.



Description



Function returns next to the lowest byte of number. Function does not interpret bit patterns of number – it merely returns 8 bits as found in register. This is an “inline” routine; code is generated in the place of the call, so the call doesn’t count against the nested call limit.



Requires



Arguments must be scalar type (i.e. Arithmetic Types and Pointers).



Example



d = 0x1AC30F4; tmp = Hi(d); // Equals 0x30



Higher Prototype



unsigned short Higher(long number);



Returns



Returns next to the highest byte of number, bits 16..23.



Description



Function returns next to the highest byte of number. Function does not interpret bit patterns of number – it merely returns 8 bits as found in register. This is an “inline” routine; code is generated in the place of the call, so the call doesn’t count against the nested call limit.



Requires



Arguments must be scalar type (i.e. Arithmetic Types and Pointers).



Example



d = 0x1AC30F4; tmp = Higher(d);



// Equals 0xAC



Highest Prototype



unsigned short Highest(long number);



Returns



Returns the highest byte of number, bits 24..31.



Description



Function returns the highest byte of number. Function does not interpret bit patterns of number – it merely returns 8 bits as found in register. This is an “inline” routine; code is generated in the place of the call, so the call doesn’t count against the nested call limit.



Requires



Arguments must be scalar type (i.e. Arithmetic Types and Pointers).



Example



d = 0x1AC30F4; tmp = Highest(d);



// Equals 0x01
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Delay_us Prototype



void Delay_us(const time_in_us);



Description



Creates a software delay in duration of time_in_us microseconds (a constant). Range of applicable constants depends on the oscillator frequency.



Example



Delay_us(10);



/* Ten microseconds pause */



Delay_ms Prototype



void Delay_ms(const time_in_ms);



Description



Creates a software delay in duration of time_in_ms milliseconds (a constant). Range of applicable constants depends on the oscillator frequency.



Example



Delay_ms(1000);



/* One second pause */



Vdelay_ms Prototype



void Vdelay_ms(unsigned time_in_ms);



Description



Creates a software delay in duration of time_in_ms milliseconds (a variable). Generated delay is not as precise as the delay created by Delay_ms.



Example



pause = 1000; // ... Vdelay_ms(pause);



// ~ one second pause
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Delay_Cyc Prototype



void Delay_Cyc(char Cycles_div_by_10);



Description



Creates a delay based on MCU clock. Delay lasts for 10 times the input parameter in MCU cycles. Input parameter needs to be in range 3 .. 255. Note that Delay_Cyc is library function rather than a built-in routine; it is presented in this topic for the sake of convenience.



Example



Delay_Cyc(10);



/* Hundred MCU cycles pause */



Clock_Khz Prototype



unsigned Clock_Khz(void);



Returns



Device clock in KHz, rounded to the nearest integer.



Description



Returns device clock in KHz, rounded to the nearest integer.



Example



clk = Clock_Khz();



Clock_Mhz Prototype



unsigned Clock_Mhz(void);



Returns



Device clock in MHz, rounded to the nearest integer.



Description



Returns device clock in MHz, rounded to the nearest integer.



Example



clk = Clock_Mhz();
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LIBRARY ROUTINES mikroC provides a set of libraries which simplifies the initialization and use of PIC MCU and its modules. Library functions do not require any header files to be included; you can use them anywhere in your projects. Currently available libraries are: Hardware/PIC-specific Libraries - ADC Library - CAN Library - CANSPI Library - Compact Flash Library - EEPROM Library - Ethernet Library - SPI Ethernet Library - Flash Memory Library - Graphic LCD Library - T6963C Graphic LCD Library - I²C Library - Keypad Library - LCD Library - LCD Custom Library - LCD8 Library - Manchester Code Library - Multi Media Card Library - OneWire Library - PS/2 Library - PWM Library - RS-485 Library - Software I²C Library - Software SPI Library - Software UART Library - Sound Library - SPI Library - USART Library - USB HID Library - Util Library - SPI Graphic LCD Library - Port Expander Library page
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- SPI LCD Library - SPI LCD8 Library - SPI T6963C Graphic LCD Library Standard ANSI C Libraries - ANSI C Ctype Library - ANSI C Math Library - ANSI C Stdlib Library - ANSI C String Library Miscellaneous Libraries - Conversions Library - Trigonometry Library - sprint Library - Setjmp Library - Time Library
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ADC Library ADC (Analog to Digital Converter) module is available with a number of PIC MCU models. Library function Adc_Read is included to provide you comfortable work with the module.



Adc_Read Prototype



unsigned Adc_Read(char channel);



Returns



10-bit unsigned value read from the specified ADC channel.



Description



Initializes PIC’s internal ADC module to work with RC clock. Clock determines the time period necessary for performing AD conversion (min 12TAD). Parameter channel represents the channel from which the analog value is to be acquired. For channel-to-pin mapping please refer to documentation for the appropriate PIC MCU.



Requires



PIC MCU with built-in ADC module. You should consult the Datasheet documentation for specific device (most devices from PIC16/18 families have it). Before using the function, be sure to configure the appropriate TRISA bits to designate the pins as input. Also, configure the desired pin as analog input, and set Vref (voltage reference value). The function is currently unsupported by the following PICmicros: P18F2331, P18F2431, P18F4331, and P18F4431.



Example



unsigned tmp; ... tmp = Adc_Read(1);



/* read analog value from channel 1 */
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Library Example /* This code snippet reads analog value from channel 2 and displays it on PORTD (lower 8 bits) and PORTB (2 most significant bits). */ unsigned temp_res; void main() { ADCON1 = 0x80; TRISA = 0xFF; TRISB = 0x3F; TRISD = 0;



// // // //



Configure analog inputs and Vref PORTA is input Pins RB7, RB6 are outputs PORTD is output



do { temp_res = Adc_Read(2); PORTD = temp_res; PORTB = temp_res >> 2; } while(1);



// Get results of AD conversion // Send lower 8 bits to PORTD // Send 2 most significant bits to RB7, RB6



}



Hardware Connection



VCC
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CAN Library mikroC provides a library (driver) for working with the CAN module. CAN is a very robust protocol that has error detection and signalling, self–checking and fault confinement. Faulty CAN data and remote frames are re-transmitted automatically, similar to the Ethernet. Data transfer rates vary from up to 1 Mbit/s at network lengths below 40m to 250 Kbit/s at 250m cables, and can go even lower at greater network distances, down to 200Kbit/s, which is the minimum bitrate defined by the standard. Cables used are shielded twisted pairs, and maximum cable length is 1000m. CAN supports two message formats: Standard format, with 11 identifier bits, and Extended format, with 29 identifier bits Note: CAN routines are currently supported only by P18XXX8 PICmicros. Microcontroller must be connected to CAN transceiver (MCP2551 or similar) which is connected to CAN bus. Note: Be sure to check CAN constants necessary for using some of the functions. See page 145.



Library Routines CANSetOperationMode CANGetOperationMode CANInitialize CANSetBaudRate CANSetMask CANSetFilter CANRead CANWrite



Following routines are for the internal use by compiler only: RegsToCANID CANIDToRegs
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CANSetOperationMode Prototype



void CANSetOperationMode(char mode, char wait_flag);



Description



Sets CAN to requested mode, i.e. copies mode to CANSTAT. Parameter mode needs to be one of CAN_OP_MODE constants (see CAN constants). Parameter wait_flag needs to be either 0 or 0xFF: If set to 0xFF, this is a blocking call – the function won’t “return” until the requested mode is set. If 0, this is a non-blocking call. It does not verify if CAN module is switched to requested mode or not. Caller must use function CANGetOperationMode to verify correct operation mode before performing mode specific operation.



Requires



CAN routines are currently supported only by P18XXX8 PICmicros. Microcontroller must be connected to CAN transceiver (MCP2551 or similar) which is connected to CAN bus.



Example



CANSetOperationMode(CAN_MODE_CONFIG, 0xFF);



CANGetOperationMode Prototype



char CANGetOperationMode(void);



Returns



Current opmode.



Description



Function returns current operational mode of CAN module.



Requires



CAN routines are currently supported only by P18XXX8 PICmicros. Microcontroller must be connected to CAN transceiver (MCP2551 or similar) which is connected to CAN bus.



Example



if (CANGetOperationMode() == CAN_MODE_NORMAL) { ... };
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CANInitialize Prototype



void CANInitialize(char SJW, char BRP, char PHSEG1, char PHSEG2, char PROPSEG, char CAN_CONFIG_FLAGS);



Description



Initializes CAN. All pending transmissions are aborted. Sets all mask registers to 0 to allow all messages. The Config mode is internaly set by this function. Upon a execution of this function Normal mode is set. Filter registers are set according to flag value: if (CAN_CONFIG_FLAGS & CAN_CONFIG_VALID_XTD_MSG != 0) // Set all filters to XTD_MSG else if (config & CONFIG_VALID_STD_MSG != 0) // Set all filters to STD_MSG else // Set half the filters to STD, and the rest to XTD_MSG



Parameters: SJW as defined in 18XXX8 datasheet (1–4) BRP as defined in 18XXX8 datasheet (1–64) PHSEG1 as defined in 18XXX8 datasheet (1–8) PHSEG2 as defined in 18XXX8 datasheet (1–8) PROPSEG as defined in 18XXX8 datasheet (1–8) CAN_CONFIG_FLAGS is formed from predefined constants (see CAN constants).



Requires



CAN routines are currently supported only by P18XXX8 PICmicros. Microcontroller must be connected to CAN transceiver (MCP2551 or similar) which is connected to CAN bus.



Example



init = CAN_CONFIG_SAMPLE_THRICE & CAN_CONFIG_PHSEG2_PRG_ON & CAN_CONFIG_STD_MSG & CAN_CONFIG_DBL_BUFFER_ON & CAN_CONFIG_VALID_XTD_MSG & CAN_CONFIG_LINE_FILTER_OFF; ... CANInitialize(1, 1, 3, 3, 1, init);



// initialize CAN
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CANSetBaudRate Prototype



void CANSetBaudRate(char SJW, char BRP, char PHSEG1, char PHSEG2, char PROPSEG, char CAN_CONFIG_FLAGS);



Description



Sets CAN baud rate. Due to complexity of CAN protocol, you cannot simply force a bps value. Instead, use this function when CAN is in Config mode. Refer to datasheet for details. Parameters: SJW as defined in 18XXX8 datasheet (1–4) BRP as defined in 18XXX8 datasheet (1–64) PHSEG1 as defined in 18XXX8 datasheet (1–8) PHSEG2 as defined in 18XXX8 datasheet (1–8) PROPSEG as defined in 18XXX8 datasheet (1–8) CAN_CONFIG_FLAGS is formed from predefined constants (see CAN constants)



Requires



CAN must be in Config mode; otherwise the function will be ignored.



Example



init = CAN_CONFIG_SAMPLE_THRICE & CAN_CONFIG_PHSEG2_PRG_ON & CAN_CONFIG_STD_MSG & CAN_CONFIG_DBL_BUFFER_ON & CAN_CONFIG_VALID_XTD_MSG & CAN_CONFIG_LINE_FILTER_OFF; ... CANSetBaudRate(1, 1, 3, 3, 1, init);
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CANSetMask Prototype



void CANSetMask(char CAN_MASK, long value, char CAN_CONFIG_FLAGS);



Description



Function sets mask for advanced filtering of messages. Given value is bit adjusted to appropriate buffer mask registers. Parameters: CAN_MASK is one of predefined constant values (see CAN constants); value is the mask register value; CAN_CONFIG_FLAGS selects type of message to filter, either CAN_CONFIG_XTD_MSG or CAN_CONFIG_STD_MSG.



Requires



CAN must be in Config mode; otherwise the function will be ignored.



Example



// Set all mask bits to 1, i.e. all filtered bits are relevant: CANSetMask(CAN_MASK_B1, -1, CAN_CONFIG_XTD_MSG); /* Note that -1 is just a cheaper way to write 0xFFFFFFFF. Complement will do the trick and fill it up with ones. */



CANSetFilter Prototype



void CANSetFilter(char CAN_FILTER, long value, char CAN_CONFIG_FLAGS);



Description



Function sets mask for advanced filtering of messages. Given value is bit adjusted to appropriate buffer mask registers. Parameters: CAN_MASK is one of predefined constant values (see CAN constants); value is the filter register value; CAN_CONFIG_FLAGS selects type of message to filter, either CAN_CONFIG_XTD_MSG or CAN_CONFIG_STD_MSG.



Requires



CAN must be in Config mode; otherwise the function will be ignored.



Example



/* Set id of filter B1_F1 to 3: */ CANSetFilter(CAN_FILTER_B1_F1, 3, CAN_CONFIG_XTD_MSG);
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CANRead Prototype



char CANRead(long *id, char *data, char *datalen, char *CAN_RX_MSG_FLAGS);



Returns



Message from receive buffer or zero if no message found.



Description



Function reads message from receive buffer. If at least one full receive buffer is found, it is extracted and returned. If none found, function returns zero. Parameters: id is message identifier; data is an array of bytes up to 8 bytes in length; datalen is data length, from 1–8; CAN_RX_MSG_FLAGS is value formed from constants (see CAN constants).



Requires



CAN must be in mode in which receiving is possible.



Example



char rcv, rx, len, data[8]; long id; rcv = CANRead(id, data, len, 0);



CANWrite Prototype



char CANWrite(long id, char *data, char datalen, char CAN_TX_MSG_FLAGS);



Returns



Returns zero if message cannot be queued (buffer full).



Description



If at least one empty transmit buffer is found, function sends message on queue for transmission. If buffer is full, function returns 0. Parameters: id is CAN message identifier. Only 11 or 29 bits may be used depending on message type (standard or extended); data is array of bytes up to 8 bytes in length; datalen is data length from 1–8; CAN_TX_MSG_FLAGS is value formed from constants (see CAN constants).



Requires



CAN must be in Normal mode.



Example



char tx, data; long id; tx = CAN_TX_PRIORITY_0 & CAN_TX_XTD_FRAME; CANWrite(id, data, 2, tx);
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CAN Constants There is a number of constants predefined in CAN library. To be able to use the library effectively, you need to be familiar with these. You might want to check the example at the end of the chapter. CAN_OP_MODE CAN_OP_MODE constants define CAN operation mode. Function CANSetOperationMode expects one of these as its argument: #define #define #define #define #define #define



CAN_MODE_BITS CAN_MODE_NORMAL CAN_MODE_SLEEP CAN_MODE_LOOP CAN_MODE_LISTEN CAN_MODE_CONFIG



0xE0 0 0x20 0x40 0x60 0x80



// Use it to access mode bits



CAN_CONFIG_FLAGS CAN_CONFIG_FLAGS constants define flags related to CAN module configuration. Functions CANInitialize and CANSetBaudRate expect one of these (or a bitwise



combination) as their argument: #define CAN_CONFIG_DEFAULT



0xFF



// 11111111



#define CAN_CONFIG_PHSEG2_PRG_BIT #define CAN_CONFIG_PHSEG2_PRG_ON #define CAN_CONFIG_PHSEG2_PRG_OFF



0x01 0xFF 0xFE



// XXXXXXX1 // XXXXXXX0



#define CAN_CONFIG_LINE_FILTER_BIT #define CAN_CONFIG_LINE_FILTER_ON #define CAN_CONFIG_LINE_FILTER_OFF



0x02 0xFF 0xFD



// XXXXXX1X // XXXXXX0X



#define CAN_CONFIG_SAMPLE_BIT #define CAN_CONFIG_SAMPLE_ONCE #define CAN_CONFIG_SAMPLE_THRICE



0x04 0xFF 0xFB



// XXXXX1XX // XXXXX0XX



#define CAN_CONFIG_MSG_TYPE_BIT #define CAN_CONFIG_STD_MSG #define CAN_CONFIG_XTD_MSG



0x08 0xFF 0xF7



// XXXX1XXX // XXXX0XXX



// continues..



page



170



MikroElektronika: Development tools - Books - Compilers



mikroC making it simple...



mikroC - C Compiler for Microchip PIC microcontrollers



// ..continued #define CAN_CONFIG_DBL_BUFFER_BIT #define CAN_CONFIG_DBL_BUFFER_ON #define CAN_CONFIG_DBL_BUFFER_OFF



0x10 0xFF 0xEF



// XXX1XXXX // XXX0XXXX



#define #define #define #define #define



0x60 0xFF 0xDF 0xBF 0x9F



// // // //



CAN_CONFIG_MSG_BITS CAN_CONFIG_ALL_MSG CAN_CONFIG_VALID_XTD_MSG CAN_CONFIG_VALID_STD_MSG CAN_CONFIG_ALL_VALID_MSG



X11XXXXX X10XXXXX X01XXXXX X00XXXXX



You may use bitwise AND (&) to form config byte out of these values. For example: init = CAN_CONFIG_SAMPLE_THRICE & CAN_CONFIG_PHSEG2_PRG_ON & CAN_CONFIG_STD_MSG & CAN_CONFIG_DBL_BUFFER_ON & CAN_CONFIG_VALID_XTD_MSG & CAN_CONFIG_LINE_FILTER_OFF; //... CANInitialize(1, 1, 3, 3, 1, init); // initialize CAN



CAN_TX_MSG_FLAGS CAN_TX_MSG_FLAGS #define #define #define #define #define



are flags related to transmission of a CAN message:



CAN_TX_PRIORITY_BITS CAN_TX_PRIORITY_0 CAN_TX_PRIORITY_1 CAN_TX_PRIORITY_2 CAN_TX_PRIORITY_3



0x03 0xFC 0xFD 0xFE 0xFF



// // // //



#define CAN_TX_FRAME_BIT #define CAN_TX_STD_FRAME #define CAN_TX_XTD_FRAME



0x08 0xFF 0xF7



// XXXXX1XX // XXXXX0XX



#define CAN_TX_RTR_BIT #define CAN_TX_NO_RTR_FRAME #define CAN_TX_RTR_FRAME



0x40 0xFF 0xBF



// X1XXXXXX // X0XXXXXX



XXXXXX00 XXXXXX01 XXXXXX10 XXXXXX11



You may use bitwise AND (&) to adjust the appropriate flags. For example: /* form value to be used with CANSendMessage: */ send_config = CAN_TX_PRIORITY_0 && CAN_TX_XTD_FRAME & CAN_TX_NO_RTR_FRAME; //... CANSendMessage(id, data, 1, send_config);
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CAN_RX_MSG_FLAGS are flags related to reception of CAN message. If a particular bit is set; corresponding meaning is TRUE or else it will be FALSE.



CAN_RX_MSG_FLAGS



#define #define #define #define #define #define #define #define #define #define #define #define



CAN_RX_FILTER_BITS CAN_RX_FILTER_1 CAN_RX_FILTER_2 CAN_RX_FILTER_3 CAN_RX_FILTER_4 CAN_RX_FILTER_5 CAN_RX_FILTER_6 CAN_RX_OVERFLOW CAN_RX_INVALID_MSG CAN_RX_XTD_FRAME CAN_RX_RTR_FRAME CAN_RX_DBL_BUFFERED



0x07 0x00 0x01 0x02 0x03 0x04 0x05 0x08 0x10 0x20 0x40 0x80



// Use it to access filter bits



// // // // // //



Set if Overflowed; else clear Set if invalid; else clear Set if XTD msg; else clear Set if RTR msg; else clear Set if msg was hardware double-buffered



You may use bitwise AND (&) to adjust the appropriate flags. For example: if (MsgFlag & CAN_RX_OVERFLOW != 0) { ... // Receiver overflow has occurred; previous message is lost. }



CAN_MASK CAN_MASK constants define mask codes. Function CANSetMask expects one of these as its argument: #define CAN_MASK_B1 #define CAN_MASK_B2



0 1



CAN_FILTER CAN_FILTER constants define filter codes. Function CANSetFilter expects one of these as its argument: #define #define #define #define #define #define



CAN_FILTER_B1_F1 CAN_FILTER_B1_F2 CAN_FILTER_B2_F1 CAN_FILTER_B2_F2 CAN_FILTER_B2_F3 CAN_FILTER_B2_F4



0 1 2 3 4 5
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Library Example unsigned short aa, aa1, len, aa2; unsigned char data[8]; long id; unsigned short zr, cont, oldstate; //........ void main() { PORTC = 0; TRISC = 0; PORTD = 0; TRISD = 0; aa = 0; aa1 = 0; aa2 = 0; // Form value to be used with CANSendMessage aa1 = CAN_TX_PRIORITY_0 & CAN_TX_XTD_FRAME & CAN_TX_NO_RTR_FRAME; // Form value to be used with CANInitialize aa = CAN_CONFIG_SAMPLE_THRICE & CAN_CONFIG_PHSEG2_PRG_ON & CAN_CONFIG_STD_MSG & CAN_CONFIG_DBL_BUFFER_ON & CAN_CONFIG_VALID_XTD_MSG & CAN_CONFIG_LINE_FILTER_OFF; data[0] = 0; // Initialize CAN CANInitialize(1,1,3,3,1,aa); // Set CAN to CONFIG mode CANSetOperationMode(CAN_MODE_CONFIG,0xFF); id = -1;



// continues ..
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// .. continued



// Set all mask1 bits to ones CANSetMask(CAN_MASK_B1,ID,CAN_CONFIG_XTD_MSG); // Set all mask2 bits to ones CANSetMask(CAN_MASK_B2,ID,CAN_CONFIG_XTD_MSG); // Set id of filter B1_F1 to 3 CANSetFilter(CAN_FILTER_B2_F3,3,CAN_CONFIG_XTD_MSG); // Set CAN to NORMAL mode CANSetOperationMode(CAN_MODE_NORMAL,0xFF); PORTD = 0xFF; id = 12111; CANWrite(id,data,1,aa1);



// Send message via CAN



while (1) { oldstate = 0; zr = CANRead(&id, data , &len, &aa2); if ((id == 3) & zr) { PORTD = 0xAA; PORTC = data[0]; data[0]++ ;



// Output data at PORTC



// If message contains two data bytes, output second byte at PORTD if (len == 2) PORTD = data[1]; data[1] = 0xFF; id = 12111; CANWrite(id, data, 2,aa1);



// Send incremented data back



} } }//~!
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Hardware Connection



CAN TX of MCU CAN RX of MCU



10 1 2



VCC



3



TX-CAN RS GND CANH



8 7 6



VCC CANL 4



RXD



Vref



5



MCP2551



Shielded pair no longer than 300m
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CANSPI Library SPI module is available with a number of PICmicros. mikroC provides a library (driver) for working with the external CAN modules (such as MCP2515 or MCP2510) via SPI. In mikroC, each routine of CAN library has its CANSPI counterpart with identical syntax. For more information on the Controller Area Network, consult the CAN Library. Note that the effective communication speed depends on the SPI, and is certainly slower than the “real” CAN. Note: CANSPI functions are supported by any PIC MCU that has SPI interface on PORTC. Also, CS pin of MCP2510 or MCP2515 must be connected to RC0. Example of HW connection is given at the end of the chapter. Note: Be sure to check CAN constants necessary for using some of the functions. See page 145. Note: SPI_Init() must be called before initializing CANSPI.



Library Routines



CANSPISetOperationMode CANSPIGetOperationMode CANSPIInitialize CANSPISetBaudRate CANSPISetMask CANSPISetFilter CANSPIRead CANSPIWrite



Following routines are for the internal use by compiler only: RegsToCANSPIID CANSPIIDToRegs
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CANSPISetOperationMode Prototype



void CANSPISetOperationMode(char mode, char wait_flag);



Description



Sets CAN to requested mode, i.e. copies mode to CANSTAT. Parameter mode needs to be one of CAN_OP_MODE constants (see CAN constants, page 145). Parameter wait_flag needs to be either 0 or 0xFF: If set to 0xFF, this is a blocking call – the function won’t “return” until the requested mode is set. If 0, this is a nonblocking call. It does not verify if CAN module is switched to requested mode or not. Caller must use function CANSPIGetOperationMode to verify correct operation mode before performing mode specific operation.



Requires



CANSPI functions are supported by any PIC MCU that has SPI interface on PORTC. Also, CS pin of MCP2510 or MCP2515 must be connected to RC0.



Example



CANSPISetOperationMode(CAN_MODE_CONFIG, 0xFF);



CANSPIGetOperationMode Prototype



char CANSPIGetOperationMode(void);



Returns



Current opmode.



Description



Function returns current operational mode of CAN module.



Example



if (CANSPIGetOperationMode() == CAN_MODE_NORMAL) { ... };
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CANSPIInitialize Prototype



void CANSPIInitialize(char SJW, char BRP, char PHSEG1, char PHSEG2, char PROPSEG, char CAN_CONFIG_FLAGS, char * RstPort, char RstPin, char * CSPort, char CSPin);



Description



Initializes CANSPI. All pending transmissions are aborted. Sets all mask registers to 0 to allow all messages. Filter registers are set according to flag value: if (CAN_CONFIG_FLAGS & CAN_CONFIG_VALID_XTD_MSG != 0) // Set all filters to XTD_MSG else if (config & CONFIG_VALID_STD_MSG != 0) // Set all filters to STD_MSG else // Set half the filters to STD, and the rest to XTD_MSG



Parameters: SJW as defined in 18XXX8 datasheet (1–4) BRP as defined in 18XXX8 datasheet (1–64) PHSEG1 as defined in 18XXX8 datasheet (1–8) PHSEG2 as defined in 18XXX8 datasheet (1–8) PROPSEG as defined in 18XXX8 datasheet (1–8) CAN_CONFIG_FLAGS is formed from predefined constants (see CAN constants, page



145). Requires



SPI_Init() must be called before initializing CANSPI. CANSPI must be in Config mode; otherwise the function will be ignored.



Example



init = CAN_CONFIG_SAMPLE_THRICE & CAN_CONFIG_PHSEG2_PRG_ON & CAN_CONFIG_STD_MSG & CAN_CONFIG_DBL_BUFFER_ON & CAN_CONFIG_VALID_XTD_MSG & CAN_CONFIG_LINE_FILTER_OFF; ... // initialize external CAN module CANSPIInitialize( 1,1,3,3,1,init, &PORTC, 2, &PORTC, 0);
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CANSPISetBaudRate Prototype



void CANSPISetBaudRate(char SJW, char BRP, char PHSEG1, char PHSEG2, char PROPSEG, char CAN_CONFIG_FLAGS);



Description



Sets CANSPI baud rate. Due to complexity of CANSPI protocol, you cannot simply force a bps value. Instead, use this function when CANSPI is in Config mode. Refer to datasheet for details. Parameters: SJW as defined in 18XXX8 datasheet (1–4) BRP as defined in 18XXX8 datasheet (1–64) PHSEG1 as defined in 18XXX8 datasheet (1–8) PHSEG2 as defined in 18XXX8 datasheet (1–8) PROPSEG as defined in 18XXX8 datasheet (1–8) CAN_CONFIG_FLAGS is formed from predefined constants (see CAN constants)



Requires



CANSPI must be in Config mode; otherwise the function will be ignored.



Example



init = CAN_CONFIG_SAMPLE_THRICE & CAN_CONFIG_PHSEG2_PRG_ON & CAN_CONFIG_STD_MSG & CAN_CONFIG_DBL_BUFFER_ON & CAN_CONFIG_VALID_XTD_MSG & CAN_CONFIG_LINE_FILTER_OFF; ... CANSPISetBaudRate(1, 1, 3, 3, 1, init);
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CANSPISetMask Prototype



void CANSPISetMask(char CAN_MASK, long value, char CAN_CONFIG_FLAGS);



Description



Function sets mask for advanced filtering of messages. Given value is bit adjusted to appropriate buffer mask registers. Parameters: CAN_MASK is one of predefined constant values (see CAN constants); value is the mask register value; CAN_CONFIG_FLAGS selects type of message to filter, either CAN_CONFIG_XTD_MSG or CAN_CONFIG_STD_MSG.



Requires



CANSPI must be in Config mode; otherwise the function will be ignored.



Example



// Set all mask bits to 1, i.e. all filtered bits are relevant: CANSPISetMask(CAN_MASK_B1, -1, CAN_CONFIG_XTD_MSG); /* Note that -1 is just a cheaper way to write 0xFFFFFFFF. Complement will do the trick and fill it up with ones. */



CANSPISetFilter Prototype



void CANSPISetFilter(char CAN_FILTER, long value, char CAN_CONFIG_FLAGS);



Description



Function sets mask for advanced filtering of messages. Given value is bit adjusted to appropriate buffer mask registers. Parameters: CAN_MASK is one of predefined constant values (see CAN constants); value is the filter register value; CAN_CONFIG_FLAGS selects type of message to filter, either CAN_CONFIG_XTD_MSG or CAN_CONFIG_STD_MSG.



Requires



CANSPI must be in Config mode; otherwise the function will be ignored.



Example



/* Set id of filter B1_F1 to 3: */ CANSPISetFilter(CAN_FILTER_B1_F1, 3, CAN_CONFIG_XTD_MSG);
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CANSPIRead Prototype



char CANSPIRead(long *id, char *data, char *datalen, char *CAN_RX_MSG_FLAGS);



Returns



Message from receive buffer or zero if no message found.



Description



Function reads message from receive buffer. If at least one full receive buffer is found, it is extracted and returned. If none found, function returns zero. Parameters: id is message identifier; data is an array of bytes up to 8 bytes in length; datalen is data length, from 1–8; CAN_RX_MSG_FLAGS is value formed from constants (see CAN constants).



Requires



CANSPI must be in mode in which receiving is possible.



Example



char rcv, rx, len, data[8]; long id; rcv = CANSPIRead(id, data, len, 0);



CANSPIWrite Prototype



char CANSPIWrite(long id, char *data, char datalen, char CAN_TX_MSG_FLAGS);



Returns



Returns zero if message cannot be queued (buffer full).



Description



If at least one empty transmit buffer is found, function sends message on queue for transmission. If buffer is full, function returns 0. Parameters: id is CANSPI message identifier. Only 11 or 29 bits may be used depending on message type (standard or extended); data is array of bytes up to 8 bytes in length; datalen is data length from 1–8; CAN_TX_MSG_FLAGS is value formed from constants (see CAN constants).



Requires



CANSPI must be in Normal mode.



Example



char tx, data; long id; tx = CAN_TX_PRIORITY_0 & CAN_TX_XTD_FRAME; CANSPIWrite(id, data, 2, tx);



page MikroElektronika: Development tools - Books - Compilers



181



mikroC mikroC - C Compiler for Microchip PIC microcontrollers



making it simple...



Library Example The code is a simple demonstration of CANSPI protocol. It is a simple data exchange between 2 PIC’s, where data is incremented upon each bounce. Data is printed on PORTC (lower byte) and PORTD (higher byte) for a visual check. char data[8],aa, aa1, len, aa2; long id; char zr; const char _TRUE = 0xFF; const char _FALSE = 0x00; void main(){ TRISB = 0; Spi_Init(); TRISC.F2 = 0; PORTC.F2 = 0; PORTC.F0 = 1; TRISC.F0 = 0; PORTD = 0; TRISD = 0; aa = 0; aa1 = 0; aa2 = 0;



// // // // //



Initialize SPI module Clear (TRISC,2) Clear (PORTC,2) Set (PORTC,0) Clear (TRISC,0)



// Form value to be used with CANSPIInitialize aa = CAN_CONFIG_SAMPLE_THRICE & CAN_CONFIG_PHSEG2_PRG_ON & CAN_CONFIG_STD_MSG & CAN_CONFIG_DBL_BUFFER_ON & CAN_CONFIG_VALID_XTD_MSG; PORTC.F2 = 1;



// Set (PORTC,2)



// Form value to be used with CANSPISendMessage aa1 = CAN_TX_PRIORITY_0 & CAN_TX_XTD_FRAME & CAN_TX_NO_RTR_FRAME; PORTC.F0 = 1;



// Set (PORTC,0)



// continues ..
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// .. continued Spi_Init(); // Initialize SPI // Initialize external CAN module CANSPIInitialize( 1,1,3,3,1,aa, &PORTC, 2, &PORTC, 0); // Set CANSPI to CONFIG mode CANSPISetOperationMode(CAN_MODE_CONFIG,_TRUE); ID = -1; // Set all mask1 bits to ones CANSPISetMask(CAN_MASK_B1,id,CAN_CONFIG_XTD_MSG); // Set all mask2 bits to ones CANSPISetMask(CAN_MASK_B2,id,CAN_CONFIG_XTD_MSG); // Set id of filter B1_F1 to 12111 CANSPISetFilter(CAN_FILTER_B2_F4,12111,CAN_CONFIG_XTD_MSG); // Set CANSPI to NORMAL mode CANSPISetOperationMode(CAN_MODE_NORMAL,_TRUE); while (1) { zr = CANSPIRead(&id , &Data , &len, &aa2); if (id == 12111 & zr ) { PORTB = data[0]++ ; id = 3; Delay_ms(500);



// Receive data, if any // Output data on PORTB



// Send incremented data back CANSPIWrite(id,&data,1,aa1); // If message contains 2 data bytes, output second byte at PORTD if (len == 2) PORTD = data[1]; } } }//~!
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Hardware Connection
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Compact Flash Library Compact Flash Library provides routines for accessing data on Compact Flash card (abbrev. CF further in text). CF cards are widely used memory elements, commonly found in digital cameras. Great capacity (8MB ~ 2GB, and more) and excellent access time of typically few microseconds make them very attractive for microcontroller applications. In CF card, data is divided into sectors, one sector usually comprising 512 bytes (few older models have sectors of 256B). Read and write operations are not performed directly, but successively through 512B buffer. Following routines can be used for CF with FAT16, and FAT32 file system. Note that routines for file handling can be used only with FAT16 file system. Important! Before write operation, make sure you don’t overwrite boot or FAT sector as it could make your card on PC or digital cam unreadable. Drive mapping tools, such as Winhex, can be of a great assistance.



Library Routines Cf_Init Cf_Detect Cf_Total_Size Cf_Enable Cf_Disable Cf_Read_Init Cf_Read_Byte Cf_Write_Init Cf_Write_Byte Cf_Fat_Init Cf_Fat_Assign Cf_Fat_Reset Cf_Fat_Read Cf_Fat_Rewrite Cf_Fat_Append Cf_Fat_Delete Cf_Fat_Write Cf_Fat_Set_File_Date Cf_Fat_Get_File_Date Cf_Fat_Get_File_Size



Function Cf_Set_Reg_Adr is for compiler internal purpose only.
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Cf_Init Prototype



void Cf_Init(char *ctrlport, char *dataport);



Description



Initializes ports appropriately for communication with CF card. Specify two different ports: ctrlport and dataport.



Example



Cf_Init(&PORTB, &PORTD);



Cf_Detect Prototype



char Cf_Detect(void);



Returns



Returns 1 if CF is present, otherwise returns 0.



Description



Checks for presence of CF card on ctrlport.



Example



// Wait until CF card is inserted: do nop; while (Cf_Detect() == 0);



Cf_Total_Size Prototype



unsigned long Cf_Total_Size(void);



Returns



Card size in kilobytes.



Description



Returns size of Compact Flash card in kilobytes.



Requires



Ports must be initialized. See Cf_Init.



Example



size = Cf_Total_Size();
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Cf_Enable Prototype



void Cf_Enable(void);



Description



Enables the device. Routine needs to be called only if you have disabled the device by means of Cf_Disable. These two routines in conjuction allow you to free/occupy data line when working with multiple devices. Check the example at the end of the chapter.



Requires



Ports must be initialized. See Cf_Init.



Example



Cf_Enable();



Cf_Disable Prototype



void Cf_Disable(void);



Description



Routine disables the device and frees the data line for other devices. To enable the device again, call Cf_Enable. These two routines in conjuction allow you to free/occupy data line when working with multiple devices. Check the example at the end of the chapter.



Requires



Ports must be initialized. See Cf_Init.



Example



Cf_Disable();



Cf_Read_Init Prototype



void Cf_Read_Init(long address, char sectcnt);



Description



Initializes CF card for reading. Parameter address specifies sector address from where data will be read, and sectcnt is the number of sectors prepared for reading operation.



Requires



Ports must be initialized. See Cf_Init.



Example



Cf_Read_Init(590, 1);
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Cf_Read_Byte Prototype



char Cf_Read_Byte(void);



Returns



Returns byte from CF.



Description



Reads one byte from CF.



Requires



CF must be initialized for read operation. See Cf_Read_Init.



Example



PORTC = Cf_Read_Byte();



// Read byte and display it on PORTC



Cf_Write_Init Prototype



void Cf_Write_Init(long address, char sectcnt);



Description



Initializes CF card for writing. Parameter address specifies sector address where data will be stored, and sectcnt is total number of sectors prepared for write operation.



Requires



Ports must be initialized. See Cf_Init.



Example



Cf_Write_Init(590, 1);



Cf_Write_Byte Prototype



void Cf_Write_Byte(char data);



Description



Writes one byte (data) to CF. All 512 bytes are transferred to a buffer.



Requires



CF must be initialized for write operation. See Cf_Write_Init.



Example



Cf_Write_Byte(100);
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Cf_Fat_Init Prototype



void Cf_Fat_Init(unsigned short *control_port, unsigned short wr, rd, a2, a1, a0, ry, ce, cd, unsigned short *data_port);



Returns



Returns 0 if initialization is successful, 1 if boot sector was not found and 255 if card was not detected.



Description



Initializes ports appropriately for FAT operations with CF card. Specify two different ports: ctrlport and dataport. wr, rd, a2, a1, a0, ry, ce and cd are pin nummbers on control port.



Requires



Nothing.



Example



CF_Fat_Init(PORTD,6,5,2,1,0,7,3,4, PORTC);



Cf_Fat_Assign Prototype



unsigned short Cf_Fat_Assign(char *filename, char create_file);



Returns



"1" is file is present(or file isn't present but new file is created), or "0" if file isn't present and no new file is created.



Description



Assigns file for FAT operations. If file isn't present, function creates new file with given filename. filename parameter is name of file (filename must be in format 8.3 UPPERCASE). create_file is a parameter for creating new files. if create_file if different from 0 then new file is created (if there is no file with given filename).



Requires



Ports must be initialized for FAT operations with CF. See Cf_Fat_Init.



Example



Cf_Fat_Assign('MIKROELE.TXT',1);



Cf_Fat_Reset Prototype



void Cf_fat_Reset(unsigned long *size);



Returns



Size of file in bytes. Size is stored on address of input variable.



Description



Opens assigned file for reading.



Requires



Ports must be initialized for FAT operations with CF. See Cf_Fat_Init. File must be assigned. See Cf_Fat_Assign.



Example



Cf_Fat_Reset(size);
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Cf_Fat_Read Prototype



void Cf_Fat_Read(unsigned short *bdata);



Description



Reads data from file. bdata is data read from file.



Requires



Ports must be initialized for FAT operations with CF. See Cf_Fat_Init. File must be assigned. See Cf_Fat_Assign. File must be open for reading. See Cf_Fat_Reset.



Example



Cf_Fat_Read(character);



Cf_Fat_Rewrite Prototype



void Cf_Fat_Rewrite();



Returns



Nothing.



Description



Rewrites assigned file.



Requires



Ports must be initialized for FAT operations with CF. See Cf_Fat_Init. File must be assigned. See Cf_Fat_Assign.



Example



Cf_Fat_Rewrite;



Cf_Fat_Append Prototype



void Cf_fat_Append();



Returns



Nothing.



Description



Opens file for writing. This procedure continues writing from the last byte in file.



Requires



Ports must be initialized for FAT operations with CF. See Cf_Fat_Init. File must be assigned. See Cf_Fat_Assign.



Example



Cf_Fat_Append;
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Cf_Fat_Delete Prototype



void Cf_Fat_Delete();



Description



Deletes file from CF.



Requires



Ports must be initialized for FAT operations with CF. See Cf_Fat_Init. File must be assigned. See Cf_Fat_Assign.



Example



Cf_Fat_Delete;



Cf_Fat_Write Prototype



void Cf_Fat_Write(char *fdata, unsigned data_len);



Returns



Nothing.



Description



Writes data to CF. fdata parameter is data written to CF. data_len number of bytes that is written to CF.



Requires



Ports must be initialized for FAT operations with CF. See Cf_Fat_Init. File must be assigned. See Cf_Fat_Assign. File must be open for writing. See Cf_Fat_Rewrite or Cf_Fat_Append.



Example



Cf_Fat_Write(file_contents, 42); // write data to the assigned file



Cf_Fat_Set_File_Date Prototype



void Cf_fat_Set_File_Date(unsigned int year, unsigned short month, unsigned short day, unsigned short hours, unsigned short mins, unsigned short seconds);



Returns



Nothing.



Description



Sets time attributes of file.You can set file year, month, day. hours, mins, seconds.



Requires



Ports must be initialized for FAT operations with CF. See Cf_Fat_Init. File must be assigned. See Cf_Fat_Assign. File must be open for writing. See Cf_Fat_Rewrite or Cf_Fat_Append.



Example



Cf_Fat_Set_File_Date(2005,9,30,17,41,0);
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Cf_Fat_Get_File_Date Prototype



void Cf_Fat_Get_File_Date(unsigned int *year, unsigned short *month, unsigned short *day, unsigned short *hours, unsigned short *mins);



Description



Reads time attributes of file.You can read file year, month, day. hours, mins.



Requires



Ports must be initialized for FAT operations with CF. See Cf_Fat_Init. File must be assigned. See Cf_Fat_Assign.



Example



Cf_Fat_Get_File_Date(year, month, day, hours, mins);



Cf_Fat_Get_File_Size Prototype



unsigned long Cf_fat_Get_File_Size();



Returns



Size of file in bytes.



Description



This function returns size of file in bytes.



Requires



Ports must be initialized for FAT operations with CF. See Cf_Fat_Init. File must be assigned. See Cf_Fat_Assign.



Example



Cf_Fat_Get_File_Size;
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Library Example The following example writes 512 bytes at sector no.590, and then reads the data and prints on PORTC for a visual check. unsigned i; void main() { TRISC = 0; Cf_Init(&PORTB, &PORTD);



// PORTC is output // Initialize ports



do nop; while (!Cf_Detect());



// Wait until CF card is inserted



Delay_ms(500); Cf_Write_Init(590, 1);



// Initialize write at sector address 590



// Write 512 bytes to sector (590) for (i = 0; i < 512; i++) Cf_Write_Byte(i + 11); PORTC = 0xFF; Delay_ms(1000); Cf_Read_Init(590, 1);



// Initialize read at sector address 590



// Read 512 bytes from sector (590) for (i = 0; i < 512; i++) { PORTC = Cf_Read_Byte(); // Read byte and display on PORTC Delay_ms(1000); } }
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Compact Flash FAT Library v2.xx This is Compact Flash FAT library from previous version (v2.1). This library is included because of users that have developed projects with old CF library. NOTE This version of Compact Flash FAT library is deprecated. There will be no longer development for this version of library. Please use new version of Compact Flash library for your projects. Important! File accessing routines can write file. File names must be exactly 8 characters long and written in uppercase. User must ensure different names for each file, as CF routines will not check for possible match. Important! Before write operation, make sure you don’t overwrite boot or FAT sector as it could make your card on PC or digital cam unreadable. Drive mapping tools, such as Winhex, can be of a great assistance.



Library Routines Cf_Find_File Cf_File_Write_Init Cf_File_Write_Byte Cf_Read_Sector Cf_Write_Sector Cf_Set_File_Date Cf_File_Write_Complete



Cf_Find_File Prototype



void Cf_Find_File(unsigned short find_first, char *file_name);



Description



Routine looks for files on CF card. Parameter find_first can be non-zero or zero; if nonzero, routine looks for the first file on card, in order of physical writing. Otherwise, routine “moves forward” to the next file from the current position, again in physical order. If file is found, routine writes its name and extension in the string file_name. If no file is found, the string will be filled with zeroes.



Requires



Ports must be initialized.



Example



Cf_Find_File(1, file); if (file[0]) { ...// if first file found, handle it}



page MikroElektronika: Development tools - Books - Compilers



195



mikroC mikroC - C Compiler for Microchip PIC microcontrollers



making it simple...



Cf_File_Write_Init Prototype



void Cf_File_Write_Init(void);



Description



Initializes CF card for file writing operation (FAT16 only).



Requires



Ports must be initialized. See Cf_Init.



Example



Cf_File_Write_Init();



Cf_File_Write_Byte Prototype



void Cf_File_Write_Byte(char data);



Description



Adds one byte (data) to file. You can supply ASCII value as parameter, for example 48 for zero.



Requires



CF must be initialized for file write operation. See Cf_File_Write_Init.



Example



// Write 50,000 zeroes (bytes) to file: for (i = 0; i < 50000; i++) Cf_File_Write_Byte(48);



Cf_Read_Sector Prototype



void Cf_Read_Sector(int sector_number, unsigned short *buffer);



Description



Reads one sector (sector_number) into buffer.



Requires



CF must be initialized for file write operation. See Cf_Init.



Example



Cf_Read_Sector(22, data);
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Cf_Write_Sector Prototype



void Cf_Write_Sector(int sector_number, unsigned short *buffer);



Description



Writes value from buffer to CF sector at sector_number.



Requires



CF must be initialized for file write operation. See Cf_Init.



Example



Cf_Write_Sector(22, data);



Cf_Set_File_Date Prototype



void Cf_Set_File_Date(int year, char month,day,hours,min,sec);



Description



Writes system timestamp to a file. Use this routine before finalizing a file; otherwise, file will be appended a random timestamp.



Requires



CF must be initialized for file write operation. See Cf_File_Write_Init.



Example



// April 1st 2005, 18:07:00 Cf_Set_File_Date(2005,4,1,18,7,0);



Cf_File_Write_Complete Prototype



void Cf_File_Write_Complete(char filename[8], char *extension);



Description



Finalizes writing to file. Upon all data has be written to file, use this function to close the file and make it readable. Parameter filename must be 8 chars long in uppercase.



Requires



CF must be initialized for file write operation. See Cf_File_Write_Init.



Example



Cf_File_Write_Complete("MY_FILE1","txt");
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EEPROM Library EEPROM data memory is available with a number of PICmicros. mikroC includes library for comfortable work with EEPROM.



Library Routines Eeprom_Read Eeprom_Write



Eeprom_Read Prototype



unsigned short Eeprom_Read(unsigned short address);



Returns



Returns byte from the specified address.



Description



Reads data from specified address. Parameter address is of integer type, which means it supports MCUs with more than 256 bytes of EEPROM.



Requires



Requires EEPROM module. Ensure minimum 20ms delay between successive use of routines Eeprom_Write and Eeprom_Read. Although PIC will write the correct value, Eeprom_Read might return an undefined result.



Example



char take; ... take = Eeprom_Read(0x3F);
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Eeprom_Read Prototype



void Eeprom_Write(unsigned int address, unsigned short data);



Description



Writes data to specified address. PParameter address is of integer type, which means it supports MCUs with more than 256 bytes of EEPROM. Be aware that all interrupts will be disabled during execution of Eeprom_Write routine (GIE bit of INTCON register will be cleared). Routine will restore previous state of this bit on exit.



Requires



Requires EEPROM module. Ensure minimum 20ms delay between successive use of routines Eeprom_Write and Eeprom_Read. Although PIC will write the correct value, Eeprom_Read might return an undefined result.



Example



Eeprom_Write(0x32);



Library Example unsigned short i = 0, j = 0; void main() { PORTB = 0; TRISB = 0; j = 4; for (i = 0; i < 20u; i++) Eeprom_Write(i, j++); for (i = 0; i < 20u; i++) { PORTB = Eeprom_Read(i); Delay_ms(500); } }//~!
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Ethernet Library This library is designed to simplify handling of the underlying hardware (RTL8019AS). However, certain level of knowledge about the Ethernet and Ethernet-based protocols (ARP, IP, TCP/IP, UDP/IP, ICMP/IP) is expected from the user. The Ethernet is a high–speed and versatile protocol, but it is not a simple one. Once you get used to it, however, you will make your favorite PIC available to a much broader audience than you could do with the RS232/485 or CAN.



Library Routines Eth_Init Eth_Set_Ip_Address Eth_Inport Eth_Scan_For_Event Eth_Get_Ip_Hdr_Len Eth_Load_Ip_Packet Eth_Get_Hdr_Chksum Eth_Get_Source_Ip_Address Eth_Get_Dest_Ip_Address Eth_Arp_Response Eth_Get_Icmp_Info Eth_Ping_Response Eth_Get_Udp_Source_Port Eth_Get_Udp_Dest_Port Eth_Get_Udp_Port Eth_Set_Udp_Port Eth_Send_Udp Eth_Load_Tcp_Header Eth_Get_Tcp_Hdr_Offset Eth_Get_Tcp_Flags Eth_Set_Tcp_Data Eth_Tcp_Response
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Eth_Init Prototype



void Eth_Init(char *addrP, char *dataP, char *ctrlP, char pinReset, char pinIOW, char pinIOR);



Description



Performs initialization of Ethernet card and library. This includes: - Setting of control and data ports; - Initialization of the Ethernet card (also called the Network Interface Card, or NIC); - Retrieval and local storage of the NIC’s hardware (MAC) address; - Putting the NIC into the LISTEN mode. Parameter addrP is a pointer to address port, which handles the addressing lines. Parameter dataP is pointer to data port. Parameter ctrlP is the control port. Parameter pinReset is the reset/enable pin for the ethernet card chip (on control port). Parameter pinIOW is the I/O Write request control pin. Parameter pinIOR is the I/O read request control pin.



Requires



As specified for the entire library (please see top of this page).



Example



Eth_Init(&PORTB, &PORTD, &PORTE, 2, 1, 0);



Eth_Set_Ip_Address Prototype



void Eth_Set_Ip_Address(char ip1, char ip2, char ip3, char ip4);



Description



Sets the IP address of the connected and initialized Ethernet network card. The arguments are the IP address numbers, in IPv4 format (e.g. 127.0.0.1).



Requires



This function should be called immediately after the NIC initialization (see Eth_Init). You can change your IP address at any time, anywhere in the code.



Example



// Set IP address 192.168.20.25 Eth_Set_Ip_Address(192u, 168u, 20u, 25u);
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Eth_Set_Inport Prototype



unsigned short Eth_Inport(unsigned short address);



Returns



One byte from the specified address.



Description



Retrieves a byte from the specified address of the Ethernet card chip.



Requires



The card (NIC) must be properly initialized. See Eth_Init.



Example



udp_length |= Eth_Inport(NIC_DATA);



Eth_Scan_For_Event Prototype



unsigned Eth_Scan_For_Event(unsigned short *next_ptr);



Returns



Type of the ethernet packet received. Two types are distinguished: ARP (MAC-IP address data request) and IP (Internet Protocol).



Description



Retrieves sender’s MAC (hardware) address and type of the packet received. The function argument is an (internal) pointer to the next data packet in RTL8019’s buffer, and is of no particular importance to the end user.



Requires



The card (NIC) must be properly initialized. See Eth_Init. Also, the function must be called in a proper sequence, i.e. right after the card init, and IP address/UDP port init.



Example



Eth_Init(&PORTB, &PORTD, &PORTE, 2, 1, 0); Eth_Set_Ip_Address(192u, 168u, 20u, 25u); Eth_Set_Udp_Port(10001); do { // Main block of every Ethernet example event_type = Eth_Scan_For_Event(&next_ptr); if (event_type) { switch (event_type) {case ARP: Arp_Event(); break; case IP : Ip_Event();} Eth_Outport(CR, 0x22); Eth_Outport(BNDRY, next_ptr); } } while (1);
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Eth_Get_Ip_Hdr_Len Prototype



unsigned short Eth_Get_Ip_Hdr_Len(void);



Returns



Header length of the received IP packet.



Description



Returns header length of the received IP packet. Before other data based upon the IP protocol (TCP, UDP, ICMP) can be analyzed, the sub-protocol data must be properly loaded from the received IP packet.



Requires



The card (NIC) must be properly initialized. See Eth_Init. The function must be called in a proper sequence, i.e. immediately after determining that the packet received is the IP packet.



Example



// Receive IP Header opt_len = Eth_Get_Ip_Hdr_Len() - 20;



Eth_Load_Ip_Packet Prototype



void Eth_Load_Ip_Packet(void);



Description



Loads various IP packet data into PIC’s Ethernet variables.



Requires



The card (NIC) must be properly initialized. See Eth_Init. Also, a proper sequence of calls must be obeyed (see the Ip_Event function in the supplied Ethernet example).



Example



Eth_Load_Ip_Packet();
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Eth_Get_Hdr_Chksum Prototype



void Eth_Get_Hdr_Chksum(void);



Description



Loads and returns the header checksum of the received IP packet.



Requires



The card (NIC) must be properly initialized. See Eth_Init. Also, a proper sequence of calls must be obeyed (see the Ip_Event function in the supplied Ethernet example).



Example



Eth_Get_Hdr_Chksum();



Eth_Get_Source_Ip_Address Prototype



void Eth_Get_Source_Ip_Address(void);



Description



Loads and returns the IP address of the sender of the received IP packet.



Requires



The card (NIC) must be properly initialized. See Eth_Init. Also, a proper sequence of calls must be obeyed (see the Ip_Event function in the supplied Ethernet example).



Example



Eth_Get_Source_Ip_Address();



Eth_Get_Dest_Ip_Address Prototype



void Eth_Get_Dest_Ip_Address(void);



Description



Loads the IP address of the received IP packet for which the packet is designated.



Requires



The card (NIC) must be properly initialized. See Eth_Init. Also, a proper sequence of calls must be obeyed (see the Ip_Event function in the supplied Ethernet example).



Example



Eth_Get_Dest_Ip_Address();
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Eth_Arp_Response Prototype



void Eth_Arp_Response(void);



Description



An automated ARP response. User should simply call this function once he detects the ARP event on the NIC.



Requires



As specified for the entire library.



Example



Eth_Arp_Response();



Eth_Get_Icmp_Info Prototype



void Eth_Get_Icmp_Info(void);



Description



Loads ICMP protocol information (from the header of the received ICMP packet) and stores it to the PIC’s Ethernet variables.



Requires



The card (NIC) must be properly initialized. See Eth_Init. Also, this function must be called in a proper sequence, and before the Eth_Ping_Response.



Example



Eth_Get_Icmp_Info();



Eth_Ping_Response Prototype



void Eth_Ping_Response(void);



Description



An automated ICMP (Ping) response. User should call this function when answerring to an ICMP/IP event.



Requires



As specified for the entire library.



Example



Eth_Ping_Response();
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Eth_Get_Udp_Source_Port Prototype



unsigned Eth_Get_Udp_Source_Port(void);



Returns



Returns the source port (socket) of the received UDP packet.



Description



The function returns the source port (socket) of the received UDP packet. After the reception of valid IP packet is detected and its type is determined to be UDP, the UDP packet header must be interpreted. UDP source port is the first data in the UDP header.



Requires



This function must be called in a proper sequence, i.e. immediately after interpretation of the IP packet header (at the very beginning of UDP packet header retrieval).



Example



udp_source_port = Eth_Get_Udp_Source_Port();



Eth_Get_Udp_Dest_Port Prototype



unsigned Eth_Get_Udp_Dest_Port(void);



Returns



Returns the destination port of the received UDP packet.



Description



The function returns the destination port of the received UDP packet. The second information contained in the UDP packet header is the destination port (socket) to which the packet is targeted.



Requires



This function must be called in a proper sequence, i.e. immediately after calling the Eth_Get_Udp_Source_Port function.



Example



udp_dest_port = Eth_Get_Udp_Dest_Port();
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Eth_Get_Udp_Port Prototype



unsigned short Eth_Get_Udp_Port(void);



Returns



Returns the UDP port (socket) number that is set for the PIC’s Ethernet card.



Description



The function returns the UDP port (socket) number that is set for the PIC's Ethernet card. After the UDP port is set at the beginning of the session (Eth_Set_Udp_Port), its number is later used to test whether the received UDP packet is targeted at the port we are using.



Requires



The network card must be properly initialized (see Eth_Init), and the UDP port propely set (see Eth_Set_Udp_Port). This library currently supports working with only one UDP port (socket) at a time.



Example



if (udp_dest_port == Eth_Get_Udp_Port()) { ... // Respond to action }



Eth_Set_Udp_Port Prototype



void Eth_Set_Udp_Port(unsigned udp_port);



Description



Sets up the default UDP port, which will handle user requests. The user can decide, upon receiving the UDP packet, which port was this packet sent to, and whether it will be handled or rejected.



Requires



As specified for the entire library.



Example



Eth_Set_Udp_Port(10001);
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Eth_Send_Udp Prototype



void Eth_Send_Udp(char *msg);



Description



Sends the prepared UDP message (msg), of up to 16 bytes (characters). Unlike ICMP and TCP, the UDP packets are generally not generated as a response to the client request. UDP provides no guarantees for message delivery and sender retains no state on UDP messages once sent onto the network. This is why UDP packets are simply sent, instead of being a response to someone’s request.



Requires



As specified for the entire library. Also, the message to be sent must be formatted as a null-terminated string. The message length, including the trailing “0”, must not exceed 16 characters.



Example



Eth_Send_Udp(udp_tx_message);



Eth_Load_Tcp_Header Prototype



void Eth_Load_Tcp_Header(void);



Description



Loads various TCP Header data into PIC’s Ethernet variables.



Requires



This function must be called in a proper sequence, i.e. immediately after retrieving the source and destination port (socket) of the TCP message.



Example



// retrieve 'source port' tcp_source_port = Eth_Inport(NIC_DATA) 10) kp += 54; else kp += 47; //--- print it Lcd_Chr(1, 10, WordToStr(cnt, Lcd_Out(2, 10,



on LCD kp); txt); txt);



} while (1); }//~!
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LCD Library (4-bit interface) mikroC provides a library for communicating with commonly used LCD (4-bit interface). Figures showing HW connection of PIC and LCD are given at the end of the chapter. Note: Be sure to designate port with LCD as output, before using any of the following library functions.



Library Routines Lcd_Config Lcd_Init Lcd_Out Lcd_Out_Cp Lcd_Chr Lcd_Chr_Cp Lcd_Cmd



Lcd_Config Prototype



void Lcd_Config(char *port, char RS, char EN, char WR, char D7, char D6, char D5, char D4);



Description



Initializes LCD at port with pin settings you specify: parameters RS, EN, WR, D7 .. D4 need to be a combination of values 0–7 (e.g. 3,6,0,7,2,1,4).



Example



Lcd_Config(&PORTD,1,2,0,3,5,4,6);
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Lcd_Init Prototype



void Lcd_Init(char *port);



Description



Initializes LCD at port with default pin settings (see the connection scheme at the end of the chapter): D7 -> PORT.7, D6 -> PORT.6, D5 -> PORT.5, D4 -> PORT.4, E -> PORT.3, RS -> PORT.2.



Example



Lcd_Init(&PORTB);



Lcd_Out Prototype



void Lcd_Out(char row, char col, char *text);



Description



Prints text on LCD at specified row and column (parameter row and col). Both string variables and literals can be passed as text.



Requires



Port with LCD must be initialized. See Lcd_Config or Lcd_Init.



Example



Lcd_Out(1, 3, "Hello!"); // Print "Hello!" at line 1, char 3



Lcd_Out_Cp Prototype



void Lcd_Out_Cp(char *text);



Description



Prints text on LCD at current cursor position. Both string variables and literals can be passed as text.



Requires



Port with LCD must be initialized. See Lcd_Config or Lcd_Init.



Example



Lcd_Out_Cp("Here!"); // Print "Here!" at current cursor position
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Lcd_Chr Prototype



void Lcd_Chr(char row, char col, char character);



Description



Prints character on LCD at specified row and column (parameters row and col). Both variables and literals can be passed as character.



Requires



Port with LCD must be initialized. See Lcd_Config or Lcd_Init.



Example



Lcd_Out(2, 3, 'i');



// Print 'i' at line 2, char 3



Lcd_Chr_Cp Prototype



void Lcd_Chr_Cp(char character);



Description



Prints character on LCD at current cursor position. Both variables and literals can be passed as character.



Requires



Port with LCD must be initialized. See Lcd_Config or Lcd_Init.



Example



Lcd_Out_Cp('e');



// Print 'e' at current cursor position



Lcd_Cmd Prototype



void Lcd_Cmd(char command);



Description



Sends command to LCD. You can pass one of the predefined constants to the function. The complete list of available commands is shown on the following page.



Requires



Port with LCD must be initialized. See Lcd_Config or Lcd_Init.



Example



Lcd_Cmd(Lcd_Clear);



// Clear LCD display



page



238



MikroElektronika: Development tools - Books - Compilers



mikroC making it simple...



mikroC - C Compiler for Microchip PIC microcontrollers



LCD Commands



LCD Command



Purpose



LCD_FIRST_ROW



Move cursor to 1st row



LCD_SECOND_ROW



Move cursor to 2nd row



LCD_THIRD_ROW



Move cursor to 3rd row



LCD_FOURTH_ROW



Move cursor to 4th row



LCD_CLEAR



Clear display



LCD_RETURN_HOME



Return cursor to home position, returns a shifted display to original position. Display data RAM is unaffected.



LCD_CURSOR_OFF



Turn off cursor



LCD_UNDERLINE_ON



Underline cursor on



LCD_BLINK_CURSOR_ON



Blink cursor on



LCD_MOVE_CURSOR_LEFT



Move cursor left without changing display data RAM



LCD_MOVE_CURSOR_RIGHT



Move cursor right without changing display data RAM



LCD_TURN_ON



Turn LCD display on



LCD_TURN_OFF



Turn LCD display off



LCD_SHIFT_LEFT



Shift display left without changing display data RAM



LCD_SHIFT_RIGHT



Shift display right without changing display data RAM
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Library Example (default pin settings) char *text = "mikroElektronika"; void main() { TRISB = 0; Lcd_Init(&PORTB); Lcd_Cmd(Lcd_CLEAR); Lcd_Cmd(Lcd_CURSOR_OFF); Lcd_Out(1, 1, text); }//~!



// // // // //



PORTB is output Initialize LCD connected to PORTB Clear display Turn cursor off Print text to LCD, 2nd row, 1st column
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LCD Custom Library (4-bit interface) mikroC provides a library for communicating with commonly used LCD (4-bit interface). Figures showing custom HW connection of PIC and LCD are given at the end of the chapter.



Library Routines Lcd_Custom_Config Lcd_Custom_Out Lcd_Custom_Out_Cp Lcd_Custom_Chr Lcd_Custom_Chr_Cp Lcd_Custom_Cmd



Lcd_Custom_Config Prototype



void Lcd_Custom_Config(char * data_port, char D7, char D6, char D5, char D4, char * ctrl_port, char RS, char WR, char EN);



Description



Initializes LCD data port and control port with pin settings you specify.



Example



Lcd_Custom_Config(&PORTD,3,2,1,0,&PORTB,2,3,4);
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Lcd_Custom_Out Prototype



void Lcd_Custom_Out(char row, char col, char *text);



Description



Prints text on LCD at specified row and column (parameter row and col). Both string variables and literals can be passed as text.



Requires



Port with LCD must be initialized. See Lcd_Config.



Example



Lcd_Custom_Out(1, 3, "Hello!");//Print "Hello!" at line 1, char 3



Lcd_Custom_Out_Cp Prototype



void Lcd_Custom_Out_Cp(char *text);



Description



Prints text on LCD at current cursor position. Both string variables and literals can be passed as text.



Requires



Port with LCD must be initialized. See Lcd_Config.



Example



Lcd_Custom_Out_Cp("Here!"); // Print "Here!" at current cursor position
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Lcd_Custom_Chr Prototype



void Lcd_Custom_Chr(char row, char col, char character);



Description



Prints character on LCD at specified row and column (parameters row and col). Both variables and literals can be passed as character.



Requires



Port with LCD must be initialized. See Lcd_Config.



Example



Lcd_Custom_Chr(2, 3, 'i');



// Print 'i' at line 2, char 3



Lcd_Custom_Chr_Cp Prototype



void Lcd_Custom_Chr_Cp(char character);



Description



Prints character on LCD at current cursor position. Both variables and literals can be passed as character.



Requires



Port with LCD must be initialized. See Lcd_Config.



Example



Lcd_Custom_Out_Cp('e');



// Print 'e' at current cursor position



Lcd_Custom_Cmd Prototype



void Lcd_Custom_Cmd(char command);



Description



Sends command to LCD. You can pass one of the predefined constants to the function. The complete list of available commands is shown on the following page.



Requires



Port with LCD must be initialized. See Lcd_Config.



Example



Lcd_Custom_Cmd(Lcd_Clear);



// Clear LCD display
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LCD Commands



LCD Command



Purpose



LCD_FIRST_ROW



Move cursor to 1st row



LCD_SECOND_ROW



Move cursor to 2nd row



LCD_THIRD_ROW



Move cursor to 3rd row



LCD_FOURTH_ROW



Move cursor to 4th row



LCD_CLEAR



Clear display



LCD_RETURN_HOME



Return cursor to home position, returns a shifted display to original position. Display data RAM is unaffected.



LCD_CURSOR_OFF



Turn off cursor



LCD_UNDERLINE_ON



Underline cursor on



LCD_BLINK_CURSOR_ON



Blink cursor on



LCD_MOVE_CURSOR_LEFT



Move cursor left without changing display data RAM



LCD_MOVE_CURSOR_RIGHT



Move cursor right without changing display data RAM



LCD_TURN_ON



Turn LCD display on



LCD_TURN_OFF



Turn LCD display off



LCD_SHIFT_LEFT



Shift display left without changing display data RAM



LCD_SHIFT_RIGHT



Shift display right without changing display data RAM
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Library Example (default pin settings) char *text = "mikroElektronika"; void main() { TRISB = 0; // PORTB is output Lcd_Custom_Config(&PORTB,7,6,5,4,&PORTB,3,0,2);// Initialize LCD connected to PORTB Lcd_Custom_Cmd(Lcd_CLEAR); // Clear display Lcd_Custom_Cmd(Lcd_CURSOR_OFF); // Turn cursor off Lcd_Custom_Out(1, 1, text); // Print text to LCD, 2nd row, 1st column }//~!
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LCD8 Library (8-bit interface) mikroC provides a library for communicating with commonly used 8-bit interface LCD (with Hitachi HD44780 controller). Figures showing HW connection of PIC and LCD are given at the end of the chapter.



Library Routines Lcd8_Config Lcd8_Init Lcd8_Out Lcd8_Out_Cp Lcd8_Chr Lcd8_Chr_Cp Lcd8_Cmd



Lcd8_Config Prototype



void Lcd8_Config(char *ctrlport, char *dataport, char RS, char EN, char WR, char D7, char D6, char D5, char D4, char D3, char D2, char D1, char D0);



Description



Initializes LCD at Control port (ctrlport) and Data port (dataport) with pin settings you specify: Parameters RS, EN, and WR need to be in range 0–7; Parameters D7 .. D0 need to be a combination of values 0–7 (e.g. 3,6,5,0,7,2,1,4).



Example



Lcd8_Config(&PORTC,&PORTD,0,1,2,6,5,4,3,7,1,2,0);
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Lcd8_Init Prototype



void Lcd8_Init(char *ctrlport, char *dataport);



Description



Initializes LCD at Control port (ctrlport) and Data port (dataport) with default pin settings (see the connection scheme at the end of the chapter): E -> ctrlport.3, RS -> ctrlport.2, R/W -> ctrlport.0, D7 -> dataport.7, D6 -> dataport.6, D5 -> dataport.5, D4 -> dataport.4, D3 -> dataport.3, D2 -> dataport.2, D1 -> dataport.1, D0 -> dataport.0



Example



Lcd8_Init(&PORTB, &PORTC);



Lcd8_Out Prototype



void Lcd8_Out(char row, char col, char *text);



Description



Prints text on LCD at specified row and column (parameter row and col). Both string variables and literals can be passed as text.



Requires



Ports with LCD must be initialized. See Lcd8_Config or Lcd8_Init.



Example



Lcd8_Out(1, 3, "Hello!");



// Print "Hello!" at line 1, char 3



Lcd8_Out_Cp Prototype



void Lcd8_Out_Cp(char *text);



Description



Prints text on LCD at current cursor position. Both string variables and literals can be passed as text.



Requires



Ports with LCD must be initialized. See Lcd8_Config or Lcd8_Init.



Example



Lcd8_Out_Cp("Here!"); // Print "Here!" at current cursor position
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Lcd8_Chr Prototype



void Lcd8_Chr(char row, char col, char character);



Description



Prints character on LCD at specified row and column (parameters row and col). Both variables and literals can be passed as character.



Requires



Ports with LCD must be initialized. See Lcd8_Config or Lcd8_Init.



Example



Lcd8_Out(2, 3, 'i');



// Print 'i' at line 2, char 3



Lcd8_Chr_Cp Prototype



void Lcd8_Chr_Cp(char character);



Description



Prints character on LCD at current cursor position. Both variables and literals can be passed as character.



Requires



Ports with LCD must be initialized. See Lcd8_Config or Lcd8_Init.



Example



Lcd8_Out_Cp('e');



// Print 'e' at current cursor position



Lcd8_Cmd Prototype



void Lcd8_Cmd(char command);



Description



Sends command to LCD. You can pass one of the predefined constants to the function. The complete list of available commands is on the page 186.



Requires



Ports with LCD must be initialized. See Lcd8_Config or Lcd8_Init.



Example



Lcd8_Cmd(Lcd_Clear);



// Clear LCD display
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Library Example (default pin settings) char *text = "mikroElektronika"; void main() { TRISB = 0; TRISC = 0; Lcd8_Init(&PORTB, &PORTC); Lcd8_Cmd(Lcd_CURSOR_OFF); Lcd8_Out(1, 1, text); }



// // // // //



PORTB is output PORTC is output Initialize LCD at PORTB and PORTC Turn off cursor Print text on LCD
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GLCD Library mikroC provides a library for drawing and writing on Graphic LCD. These routines work with commonly used GLCD 128x64, and work only with the PIC18 family.



Library Routines Basic routines: Glcd_Init Glcd_Set_Side Glcd_Set_Page Glcd_Set_X Glcd_Read_Data Glcd_Write_Data



Advanced routines: Glcd_Fill Glcd_Dot Glcd_Line Glcd_V_Line Glcd_H_Line Glcd_Rectangle Glcd_Box Glcd_Circle Glcd_Set_Font Glcd_Write_Char Glcd_Write_Text Glcd_Image
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Glcd_Init Prototype



void Glcd_Init(unsigned char *ctrl_port, char cs1, char cs2, char rs, char rw, char rst, char en, unsigned char *data_port);



Description



Initializes GLCD at lower byte of data_port with pin settings you specify. Parameters cs1, cs2, rs, rw, rst, and en can be pins of any available port. This function needs to be called befored using other routines of GLCD library.



Example



Glcd_Init(PORTB, PORTC, 3, 5, 7, 1, 2);



Glcd_Set_Side Prototype



void Glcd_Set_Side(unsigned short x);



Description



Selects side of GLCD, left or right. Parameter x specifies the side: values from 0 to 63 specify the left side, and values higher than 64 specify the right side. Use the functions Glcd_Set_Side, Glcd_Set_X, and Glcd_Set_Page to specify an exact position on GLCD. Then, you can use Glcd_Write_Data or Glcd_Read_Data on that location.



Requires



GLCD needs to be initialized. See Glcd_Init.



Example



Glcd_Select_Side(0);
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Glcd_Set_Page Prototype



void Glcd_Set_Page(unsigned short page);



Description



Selects page of GLCD, technically a line on display; parameter page can be 0..7.



Requires



GLCD needs to be initialized. See Glcd_Init.



Example



Glcd_Set_Page(5);



Glcd_Set_X Prototype



void Glcd_Set_X(unsigned short x_pos);



Description



Positions to x dots from the left border of GLCD within the given page.



Requires



GLCD needs to be initialized. See Glcd_Init.



Example



Glcd_Set_X(25);



Glcd_Read_Data Prototype



unsigned short Glcd_Read_Data(void);



Returns



One word from the GLCD memory.



Description



Reads data from from the current location of GLCD memory. Use the functions Glcd_Set_Side, Glcd_Set_X, and Glcd_Set_Page to specify an exact position on GLCD. Then, you can use Glcd_Write_Data or Glcd_Read_Data on that location.



Requires



Reads data from from the current location of GLCD memory.



Example



tmp = Glcd_Read_Data();
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Glcd_Write_Data Prototype



void Glcd_Write_Data(unsigned short data);



Description



Writes data to the current location in GLCD memory and moves to the next location.



Requires



GLCD needs to be initialized. See Glcd_Init.



Example



Glcd_Write_Data(data);



Glcd_Fill Prototype



void Glcd_Fill(unsigned short pattern);



Description



Fills the GLCD memory with byte pattern. To clear the GLCD screen, use Glcd_Fill(0); to fill the screen completely, use Glcd_Fill($FF).



Requires



GLCD needs to be initialized. See Glcd_Init.



Example



Glcd_Fill(0);



// Clear screen



Glcd_Dot Prototype



void Glcd_Dot(unsigned short x, unsigned short y, char color);



Description



Draws a dot on the GLCD at coordinates (x, y). Parameter color determines the dot state: 0 clears dot, 1 puts a dot, and 2 inverts dot state.



Requires



GLCD needs to be initialized. See Glcd_Init.



Example



Glcd_Dot(0, 0, 2); // Invert the dot in the upper left corner
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Glcd_Line Prototype



void Glcd_Line(int x1, int y1, int x2, int y2, char color);



Description



Draws a line on the GLCD from (x1, y1) to (x2, y2). Parameter color determines the dot state: 0 draws an empty line (clear dots), 1 draws a full line (put dots), and 2 draws a “smart” line (invert each dot).



Requires



GLCD needs to be initialized. See Glcd_Init.



Example



Glcd_Line(0, 63, 50, 0, 2);



Glcd_V_Line Prototype



void Glcd_V_Line(unsigned short y1, unsigned short y2, unsigned short x, char color);



Description



Similar to GLcd_Line, draws a vertical line on the GLCD from (x, y1) to (x, y2).



Requires



GLCD needs to be initialized. See Glcd_Init.



Example



Glcd_V_Line(0, 63, 0, 1);



Glcd_H_Line Prototype



void Glcd_H_Line(unsigned short x1, unsigned short x2, unsigned short y, char color);



Description



Similar to GLcd_Line, draws a horizontal line on the GLCD from (x1, y) to (x2, y).



Requires



GLCD needs to be initialized. See Glcd_Init.



Example



Glcd_H_Line(0, 127, 0, 1);
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Glcd_Rectangle Prototype



void Glcd_Rectangle(unsigned short x1, unsigned short y1, unsigned short x2, unsigned short y2, char color);



Description



Draws a rectangle on the GLCD. Parameters (x1, y1) set the upper left corner, (x2, y2) set the bottom right corner. Parameter color defines the border: 0 draws an empty border (clear dots), 1 draws a solid border (put dots), and 2 draws a “smart” border (invert each dot).



Requires



GLCD needs to be initialized. See Glcd_Init.



Example



Glcd_Rectangle(10, 0, 30, 35, 1);



Glcd_Box Prototype



void Glcd_Box(unsigned short x1, unsigned short y1, unsigned short x2, unsigned short y2, char color);



Description



Draws a box on the GLCD. Parameters (x1, y1) set the upper left corner, (x2, y2) set the bottom right corner. Parameter color defines the fill: 0 draws a white box (clear dots), 1 draws a full box (put dots), and 2 draws an inverted box (invert each dot).



Requires



GLCD needs to be initialized. See Glcd_Init.



Example



Glcd_Box(10, 0, 30, 35, 1);
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Glcd_Circle Prototype



void Glcd_Circle(int x, int y, int radius, char color);



Description



Draws a circle on the GLCD, centered at (x, y) with radius. Parameter color defines the circle line: 0 draws an empty line (clear dots), 1 draws a solid line (put dots), and 2 draws a “smart” line (invert each dot).



Requires



GLCD needs to be initialized. See Glcd_Init.



Example



Glcd_Circle(63, 31, 25, 2);



Glcd_Set_Font Prototype



void Glcd_Set_Font(const char *font, unsigned short font_width, unsigned short font_height, unsigned font_offset);



Description



Sets font for routines Glcd_Write_Char and Glcd_Write_Text. Parameter font needs to formatted in an array of byte. Parameters font_width and font_height specify the width and height of characters in dots. Font width should not exceed 128 dots, and font height shouldn’t exceed 8 dots. Parameter font_offset determines the ASCII character from which the supplied font starts. Demo fonts supplied with the library have an offset of 32, which means that they start with space. You can create your own fonts by following the guidelines given in file “GLcd_Fonts.c”. This file contains the default fonts for GLCD, and is located in your installation folder, “Extra Examples” > “GLCD”.



Requires



GLCD needs to be initialized. See Glcd_Init.



Example



// Use the custom 5x8 font "myfont" which starts with space (32): Glcd_Set_Font(myfont_5x8, 5, 8, 32);
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Glcd_Write_Char Prototype



void Glcd_Write_Char(unsigned short character, unsigned short x, unsigned short page, char color);



Description



Prints character at page (one of 8 GLCD lines, 0..7), x dots away from the left border of display. Parameter color defines the “fill”: 0 prints a “white” letter (clear dots), 1 prints a solid letter (put dots), and 2 prints a “smart” letter (invert each dot).



Requires



GLCD needs to be initialized. See Glcd_Init.



Example



Glcd_Write_Char('C', 0, 0, 1);



Glcd_Write_Text Prototype



void Glcd_Write_Text(char *text, unsigned short x, unsigned short page, unsigned short color);



Description



Prints text at page (one of 8 GLCD lines, 0..7), x dots away from the left border of display. Parameter color defines the “fill”: 0 prints a “white” letters (clear dots), 1 prints solid letters (put dots), and 2 prints “smart” letters (invert each dot).



Requires



GLCD needs to be initialized. See Glcd_Init.



Example



Glcd_Write_Text("Hello world!", 0, 0, 1);
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Glcd_Image Prototype



void Glcd_Image(const char *image);



Description



Displays bitmap image on the GLCD. Parameter image should be formatted as an array of integers. Use the mikroC’s integrated Bitmap-to-LCD editor (menu option Tools > BMP2LCD) to convert image to a constant array suitable for display on GLCD.



Requires



GLCD needs to be initialized. See Glcd_Init.



Example



Glcd_Image(my_image);
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Library Example The following drawing demo tests advanced routines of GLCD library. unsigned short j, k; void main() { Glcd_Init(PORTB, 2, 0, 3, 5, 7, 1, PORTD); // Set font for displaying text Glcd_Set_Font(@FontSystem5x8, 5, 8, 32); do { // Draw circles Glcd_Fill(0); // Clear screen Glcd_Write_Text("Circles", 0, 0, 1); j = 4; while (j < 31) { Glcd_Circle(63, 31, j, 2); j += 4; } Delay_ms(4000); // Draw boxes Glcd_Fill(0); // Clear screen Glcd_Write_Text("Rectangles", 0, 0, 1); j = 0; while (j < 31) { Glcd_Box(j, 0, j + 20, j + 25, 2); j += 4; } Delay_ms(4000); // Draw Lines Glcd_Fill(0); // Clear screen Glcd_Write_Text("Lines", 0, 0, 1); for (j = 0; j < 16; j++) { k = j*4 + 3; Glcd_Line(0, 0, 127, k, 2); } for (j = 0; j < 31; j++) { k = j*4 + 3; Glcd_Line(0, 63, k, 0, 2); } Delay_ms(4000); } while (1); }//~!
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T6963C Graphic LCD Library mikroC provides a library for drawing and writing on Toshiba T6963C Graphic LCD (changeable size).



Library Routines T6963C_Init T6963C_writeData T6963C_writeCommand T6963C_setPtr T6963C_waitReady T6963C_fill T6963C_dot T6963C_write_char T6963C_write_text T6963C_line T6963C_rectangle T6963C_box T6963C_circle T6963C_image T6963C_sprite T6963C_set_cursor T6963C_clearBit T6963C_setBit T6963C_negBit T6963C_displayGrPanel T6963C_displayTxtPanel T6963C_setGrPanel T6963C_setTxtPanel T6963C_panelFill T6963C_grFill T6963C_txtFill T6963C_cursor_height T6963C_graphics T6963C_text T6963C_cursor T6963C_cursor_blink T6963C_Init_240x128 T6963C_Init_240x64
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T6963C_init Prototype



void T6963C_init(unsigned int w, unsigned int h, unsigned int fntW, unsigned int *data, unsigned int *cntrl, unsigned int bitwr, unsigned int bitrd, unsigned int bitcd, unsigned int bitreset);



Description



Initalizes the Graphic Lcd controller. This function must be called before all T6963C Library Routines. width - Number of horizontal (x) pixels in the display. height - Number of vertical (y) pixels in the display. fntW - Font width, number of pixels in a text character, must be set accordingly to the hardware. data - Address of the port on which the Data Bus is connected. cntrl - Address of the port on which the Control Bus is connected. wr - !WR line bit number in the *cntrl port. rd - !RD line bit number in the *cntrl port. cd - !CD line bit number in the *cntrl port. rst - !RST line bit number in the *cntrl port. Display RAM : The library doesn't know the amount of available RAM. The library cuts the RAM into panels : a complete panel is one graphics panel followed by a text panel, The programer has to know his hardware to know how much panel he has.



Requires



Nothing.



Example



T6963C_init(240, 128, 8, &PORTF, &PORTD, 5, 7, 6, 4) ; /* * init display for 240 pixel width and 128 pixel height * 8 bits character width * data bus on PORTF * control bus on PORTD * bit 5 is !WR * bit 7 is !RD * bit 6 is C!D * bit 4 is RST */
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T6963C_writeData Prototype



void T6963C_writeData(unsigned char data);



Description



Routine that writes data to T6963C controller.



Requires



Ports must be initialized. See T6963C_init.



Example



T6963C_writeData(AddrL);



T6963C_writeCommand Prototype



void T6963C_writeCommand(unsigned char data);



Description



Routine that writes command to T6963C controller.



Requires



Ports must be initialized. See T6963C_init.



Example



T6963C_writeCommand(T6963C_CURSOR_POINTER_SET);



T6963C_setPtr Prototype



void T6963C_setPtr(unsigned int addr, unsigned char t);



Description



This routine sets the memory pointer p for command c.



Requires



Ports must be initialized. See T6963C_init.



Example



T6963C_writeCommand(T6963C_CURSOR_POINTER_SET);



T6963C_waitReady Prototype



void T6963C_waitReady(void);



Description



This routine pools the status byte, and loops until ready.



Requires



Ports must be initialized. See T6963C_init.



Example



T6963C_waitReady();
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T6963C_fill Prototype



void T6963C_fill(unsigned char data, unsigned int start, unsigned int len);



Description



This routine fills length with bytes to controller memory from start address.



Requires



Ports must be initialized. See T6963C_init.



Example



T6963C_fill(0x33,0x00FF,0x000F);



T6963C_dot Prototype



void T6963C_dot(int x, int y, unsigned char color);



Description



This sets current text work panel. It writes string str row x line y. mode = T6963C_ROM_MODE_[OR|EXOR|AND].



Requires



Ports must be initialized. See T6963C_init.



Example



T6963C_dot(x0, y0, pcolor);



T6963C_write_char Prototype



void T6963C_dot(int x, int y, unsigned char color);



Description



This routine sets current text work panel. It writes char c row x line y. mode = T6963C_ROM_MODE_[OR|EXOR|AND]



Requires



Ports must be initialized. See T6963C_init.



Example



T6963C_write_char('A',22,23,AND);



T6963C_write_text Prototype



void T6963C_write_text(unsigned char *str, unsigned char x, unsigned char y, unsigned char mode);



Description



This sets current text work panel. It writes string str row x line y. mode = T6963C_ROM_MODE_[OR|EXOR|AND]



Requires



Ports must be initialized. See T6963C_init.



Example



T6963C_write_text(" GLCD LIBRARY DEMO, WELCOME !", 0, 0, T6963C_ROM_MODE_XOR);
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T6963C_line Prototype



void T6963C_line(int px0, int py0, int px1, int py1, unsigned char pcolor);



Description



This routine current graphic work panel. It's draw a line from (x0, y0) to (x1, y1). pcolor = T6963C_[WHITE[BLACK]



Requires



Ports must be initialized. See T6963C_init.



Example



T6963C_line(0, 0, 239, 127, T6963C_WHITE);



T6963C_rectangle Prototype



void T6963C_rectangle(int x0, int y0, int x1, int y1, unsigned char pcolor);



Description



It sets current graphic work panel. It draws the border of the rectangle (x0, y0)-(x1, y1). pcolor = T6963C_[WHITE[BLACK].



Requires



Ports must be initialized. See T6963C_init.



Example



T6963C_rectangle(20, 20, 219, 107, T6963C_WHITE);



T6963C_box Prototype



void T6963C_box(int x0, int y0, int x1, int y1, unsigned char pcolor);



Description



This routine sets current graphic work panel. It draws a solid box in the rectangle (x0, y0)-(x1, y1). pcolor = T6963C_[WHITE[BLACK].



Requires



Ports must be initialized. See T6963C_init.



Example



T6963C_box(0, 119, 239, 127, T6963C_WHITE);
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T6963C_circle Prototype



void T6963C_circle(int x, int y, long r, unsigned char pcolor);



Description



This routine sets current graphic work panel. It draws a circle, center is (x, y), diameter is r. pcolor = T6963C_[WHITE[BLACK]



Requires



Ports must be initialized. See T6963C_init.



Example



T6963C_circle(120, 64, 110, T6963C_WHITE);



T6963C_image Prototype



void T6963C_image(const char *pic);



Description



This routine sets current graphic work panel : It fills graphic area with picture pointer by MCU. MCU must fit the display geometry. For example : for a 240x128 display, MCU must be an array of (240/8)*128 = 3840 bytes .



Requires



Ports must be initialized. See T6963C_init.



Example



T6963C_image(mc);



T6963C_sprite Prototype



void T6963C_sprite(unsigned char px, unsigned char py, const char *pic, unsigned char sx, unsigned char sy);



Description



This routine sets current graphic work panel. It fills graphic rectangle area (px, py)-(px + sx, py + sy) witch picture pointed by MCU. Sx and sy must be the size of the picture. MCU must be an array of sx*sy bytes.



Requires



Ports must be initialized. See T6963C_init.



Example



T6963C_sprite(76, 4, einstein, 88, 119); // draw a sprite
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T6963C_set_cursor Prototype



void T6963C_set_cursor(unsigned char x, unsigned char y);



Description



This routine sets cursor row x line y.



Requires



Ports must be initialized. See T6963C_init.



Example



T6963C_set_cursor(cposx, cposy);



T6963C_clearBit Prototype



void T6963C_clearBit(char b);



Description



Clear control bit.



Requires



Ports must be initialized. See T6963C_init.



Example



T6963C_clearBit(b);



T6963C_setBit Prototype



void T6963C_setBit(char b);



Description



Set control bit.



Requires



Ports must be initialized. See T6963C_init.



Example



T6963C_setBit(b);



T6963C_negBit Prototype



void T6963C_negBit(char b);



Description



Neg control bit.



Requires



Ports must be initialized. See T6963C_init.



Example



T6963C_negBit(b);
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T6963C_displayGrPanel Prototype



void T6963C_displayGrPanel(unsigned int n);



Description



Display graphic panel number n.



Requires



GLCD needs to be initialized, see T6963C_init.



Example



T6963C_displayGrPanel(n);



T6963C_displayTxtPanel Prototype



void T6963C_displayTxtPanel(unsigned int n);



Description



Display text panel number n.



Requires



GLCD needs to be initialized, see T6963C_init.



Example



T6963C_displayTxtPanel(n);



T6963C_setGrPanel Prototype



void T6963C_setGrPanel(unsigned int n);



Description



Compute graphic start address for panel number n.



Requires



Ports must be initialized. See T6963C_init.



Example



T6963C_setGrPanel(n);



T6963C_setTxtPanel Prototype



void T6963C_setTxtPanel(unsigned int n);



Description



Compute text start address for panel number n.



Requires



Ports must be initialized. See T6963C_init.



Example



T6963C_setTxtPanel(n);
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T6963C_panelFill Prototype



void T6963C_panelFill(unsigned int v);



Description



Fill full #n panel with v bitmap (0 to clear).



Requires



Ports must be initialized. See T6963C_init.



Example



T6963C_panelFill(v);



T6963C_grFill Prototype



void T6963C_grFill(unsigned int v);



Description



Fill graphic #n panel with v bitmap (0 to clear).



Requires



Ports must be initialized. See T6963C_init.



Example



T6963C_grFill(v);



T6963C_txtFill Prototype



void T6963C_txtFill(unsigned int v);



Description



Fill text #n panel with char v + 32 (0 to clear).



Requires



Ports must be initialized. See T6963C_init.



Example



T6963C_txtFill(v);



T6963C_cursor_height Prototype



void T6963C_cursor_height(unsigned int n);



Description



Set cursor size.



Requires



Ports must be initialized. See T6963C_init.



Example



T6963C_cursor_height(n);
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T6963C_graphics Prototype



void T6963C_graphics(unsigned int n);



Description



Set graphics on/off.



Requires



GLCD needs to be initialized, see T6963C_init.



Example



T6963C_graphics(1);



T6963C_text Prototype



void T6963C_text(unsigned int n);



Description



Set text on/off.



Requires



GLCD needs to be initialized, see T6963C_init.



Example



T6963C_text(1);



T6963C_cursor Prototype



void T6963C_cursor(unsigned int n);



Description



Set cursor on/off.



Requires



Ports must be initialized. See T6963C_init.



Example



T6963C_cursor(1);



T6963C_cursor_blink Prototype



void T6963C_cursor_blink(unsigned int n);



Description



Set cursor blink on/off.



Requires



Ports must be initialized. See T6963C_init.



Example



T6963C_cursor_blink(0);
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T6963C_Init_240x128 Prototype



procedure T6963C_Init_240x128;



Description



Initialize T6963C based GLCD (240x128 pixels) with default settings for mE GLCD's.



Example



T6963C_Init_240x128;



T6963C_Init_240x64 Prototype



procedure T6963C_Init_240x64;



Description



Initialize T6963C based GLCD (240x64 pixels) with default settings for mE GLCD's.



Example



T6963C_Init_240x64;



Library Example The following drawing demo tests advanced routines of T6963C GLCD library. #include "T6963C.h" /* * bitmap pictures stored in ROM */ extern const char mc[] ; extern const char einstein[] ; /* * initial PWM duty cycle for contrast power supply */ unsigned char PWM_duty = 200 ; void main(void) { unsigned unsigned unsigned unsigned



char int char int



panel ; // current panel i ; // general purpose register curs ; // cursor visibility cposx, cposy ; // cursor x-y position



TRISC = 0 ; PORTC = 0b00000000 ;



// port C is output only // chip enable, reverse on, 8x8 font



//continues...
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//continued... /* * init display for 240 pixel width and 128 pixel height * 8 bits character width * data bus on PORTD * control bus on PORTC * bit 3 is !WR * bit 1 is !RD * bit 1 is C!D * bit 5 is RST */ T6963C_Init_240x128(); //T6963C_init(240, 128, 8, &PORTD, &PORTC, 3, 2, 1, 5) ; /* * enable both graphics and text display at the same time */ T6963C_graphics(1) ; T6963C_text(1) ; panel = 0 ; i = 0 ; curs = 0 ; cposx = cposy = 0 ; /* * text messages */ T6963C_write_text(" GLCD LIBRARY DEMO, WELCOME !", 0, 0, T6963C_ROM_MODE_XOR) ; T6963C_write_text(" EINSTEIN WOULD HAVE LIKED mC", 0, 15, T6963C_ROM_MODE_XOR) ; /* * cursor */ T6963C_cursor_height(8) ; T6963C_set_cursor(0, 0) ; T6963C_cursor(0) ;



// 8 pixel height // move cursor to top left // cursor off



/* * draw rectangles */ T6963C_rectangle(0, 0, 239, 127, T6963C_WHITE) ; T6963C_rectangle(20, 20, 219, 107, T6963C_WHITE) ; T6963C_rectangle(40, 40, 199, 87, T6963C_WHITE) ; T6963C_rectangle(60, 60, 179, 67, T6963C_WHITE) ;



//continues...
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//continued... /* * draw a cross */ T6963C_line(0, 0, 239, 127, T6963C_WHITE) ; T6963C_line(0, 127, 239, 0, T6963C_WHITE) ; /* * draw solid boxes */ T6963C_box(0, 0, 239, 8, T6963C_WHITE) ; T6963C_box(0, 119, 239, 127, T6963C_WHITE) ; /* * draw circles */ T6963C_circle(120, T6963C_circle(120, T6963C_circle(120, T6963C_circle(120, T6963C_circle(120, T6963C_circle(120, T6963C_circle(120,



64, 64, 64, 64, 64, 64, 64,



10, T6963C_WHITE) ; 30, T6963C_WHITE) ; 50, T6963C_WHITE) ; 70, T6963C_WHITE) ; 90, T6963C_WHITE) ; 110, T6963C_WHITE) ; 130, T6963C_WHITE) ;



T6963C_sprite(76, 4, einstein, 88, 119) ; // draw a sprite T6963C_setGrPanel(1) ;



// select other graphic panel



T6963C_image(mc) ; // fill the graphic screen with a picture for(;;) { /* * if RB1 is pressed, toggle the display between graphic panel 0 and graphic 1 */ if(PORTB & 0b00000010) { panel++ ; panel &= 1 ; T6963C_displayGrPanel(panel) ; Delay_ms(300) ; } } //continues...
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//continued... /* * if RB2 is pressed, display only graphic panel */ else if(PORTB & 0b00000100) { T6963C_graphics(1) ; T6963C_text(0) ; Delay_ms(300) ; } /* * if RB3 is pressed, display only text panel */ else if(PORTB & 0b00001000) { T6963C_graphics(0) ; T6963C_text(1) ; Delay_ms(300) ; } /* * if RB4 is pressed, display text and graphic panels */ else if(PORTB & 0b00010000) { T6963C_graphics(1) ; T6963C_text(1) ; Delay_ms(300) ; } /* * if RB5 is pressed, change cursor */ else if(PORTB & 0b00100000) { curs++ ; if(curs == 3) curs = 0 ; switch(curs)



//continues...
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//continued... /* * move cursor, even if not visible */ cposx++ ; if(cposx == T6963C_txtCols) { cposx = 0 ; cposy++ ; if(cposy == T6963C_grHeight / T6963C_CHARACTER_HEIGHT) { cposy = 0 ; } } T6963C_set_cursor(cposx, cposy) ; Delay_ms(100) ; } }



page MikroElektronika: Development tools - Books - Compilers



277



mikroC making it simple...



mikroC - C Compiler for Microchip PIC microcontrollers



Hardware Connection



11 12 13 14 RS 16



8 Mhz



R/W 17 E 18 D0 19 D1 20
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Contrast Adjustment P1 10K
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1



mikroE EasyPIC3 Dev. tool



Toshiba T6963C Graphic LCD (240x128)
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Manchester Code Library mikroC provides a library for handling Manchester coded signals. Manchester code is a code in which data and clock signals are combined to form a single selfsynchronizing data stream; each encoded bit contains a transition at the midpoint of a bit period, the direction of transition determines whether the bit is a 0 or a 1; second half is the true bit value and the first half is the complement of the true bit value (as shown in the figure below).



Manchester RF_Send_Byte format



St1 St2 Ctr B7 B6 B5 B4 B3 B2 B1 B0 Bi-phase coding



1 2.4ms



0 Example of transmission



1 1 0 0 01 0 0 01 1



Notes: Manchester receive routines are blocking calls (Man_Receive_Config, Man_Receive_Init, Man_Receive). This means that PIC will wait until the task is performed (e.g. byte is received, synchronization achieved, etc). Routines for receiving are limited to a baud rate scope from 340 ~ 560 bps.



Library Routines Man_Receive_Config Man_Receive_Init Man_Receive Man_Send_Config Man_Send_Init Man_Send
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Man_Receive_Config Prototype



void Man_Receive_Config(char *port, char rxpin);



Description



The function prepares PIC for receiving signal. You need to specify the port and rxpin (0–7) of input signal. In case of multiple errors on reception, you should call Man_Receive_Init once again to enable synchronization.



Example



Man_Receive_Config(&PORTD, 6);



Man_Receive_Init Prototype



void Man_Receive_Init(char *port);



Description



The function prepares PIC for receiving signal. You need to specify the port; rxpin is pin 6 by default. In case of multiple errors on reception, you should call Man_Receive_Init once again to enable synchronization.



Example



Man_Receive_Init(&PORTD);



Man_Receive Prototype



void Man_Receive(char *error);



Returns



Returns one byte from signal.



Description



Function extracts one byte from signal. If signal format does not match the expected, error flag will be set to 255.



Requires



To use this function, you must first prepare the PIC for receiving. See Man_Receive_Config or Man_Receive_Init.



Example



temp = Man_Receive(error); if (error) { ... /* error handling */ }
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Man_Send_Config Prototype



void Man_Send_Config(char *port, char txpin);



Description



The function prepares PIC for sending signal. You need to specify port and txpin (0–7) for outgoing signal. Baud rate is const 500 bps.



Example



Man_Send_Config(&PORTD, 0);



Man_Send_Init Prototype



void Man_Receive_Init(char *port);



Description



The function prepares PIC for sending signal. You need to specify port for outgoing signal; txpin is pin 0 by default. Baud rate is const 500 bps.



Example



Man_Send_Init(&PORTD);



Man_Send Prototype



void Man_Send(unsigned short data);



Description



Sends one byte (data).



Requires



To use this function, you must first prepare the PIC for sending. See Man_Send_Config or Man_Send_Init.



Example



unsigned short msg; ... Man_Send(msg);
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Library Example unsigned short error, ErrorCount, IdleCount, temp, LetterCount; void main() { ErrorCount = 0; TRISC = 0; PORTC = 0; Man_Receive_Config(&PORTD, 6); Lcd_Init(&PORTB); while (1) { IdleCount = 0; do { temp = Man_Receive(error); if (error) ErrorCount++ else PORTC = 0; if (ErrorCount > 20) { ErrorCount = 0; PORTC = 0xAA; Man_Receive_Init(&PORTD); } IdleCount++; if (IdleCount > 18) { IdleCount = 0; Man_Receive_Init(&PORTD); } } while (temp != 0x0B); if (error != 255) { Lcd_Cmd(LCD_CLEAR); LetterCount = 0; while (LetterCount < 17) { LetterCount++; temp = Man_Receive(error); if (error != 255) Lcd_Chr_Cp(temp) else { ErrorCount++; break; } } temp = Man_Receive(error); if (temp != 0x0E) ErrorCount++; } // end if } // end while }//~!



// Error indicator // Synchronize receiver // Initialize LCD on PORTB // Endless loop // Reset idle counter // Attempt byte receive



// If there are too many errors // syncronize the receiver again // Indicate error // Synchronize receiver



// If nothing received after some time // try to synchronize again // Synchronize receiver // End of message marker // If no error then write the message



// Message is 16 chars long
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Hardware Connection



Transmitter RF module
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Receiver RF module Antenna
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Multi Media Card Library mikroC provides a library for accessing data on Multi Media Card via SPI communication. This library supports Secure Digital (SD) flash memory card standard also. Notes: - Library works with PIC18 family only; - Library functions create and read files from the root directory only; - Library functions populate both FAT1 and FAT2 tables when writing to files, but the file data is being read from the FAT1 table only; i.e. there is no recovery if FAT1 table is corrupted. - Since version 5.0.0.3, library can cope with media that have the Master Boot Record (MBR) in sector 0. It reads the necessary information from it, and jumps to the first available primary logical partition. For more information on MBR, physical and logiacl drives, primary/secondary partitions and partition tables, please consult other resources, e.g. Wikipedia and similar. Note: Spi_Init_Advanced(MASTER_OSC_DIV16, DATA_SAMPLE_MIDDLE, CLK_IDLE_LOW, LOW_2_HIGH); must be called before initializing Mmc_Init.



Library Routines Mmc_Init Mmc_Read_Sector Mmc_Write_Sector Mmc_Read_Cid Mmc_Read_Csd Mmc_Fat_Init Mmc_Fat_Assign Mmc_Fat_Reset Mmc_Fat_Rewrite Mmc_Fat_Append Mmc_Fat_Read Mmc_Fat_Write Mmc_Set_File_Date Mmc_Fat_Delete Mmc_Fat_Get_File_Date Mmc_Fat_Get_File_Size Mmc_Fat_Get_Swap_File
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Mmc_Init Prototype



unsigned short Mmc_Init(char *port, char pin);



Returns



Returns 0 if read was successful, or 1 if an error occurred.



Description



Initializes MMC with chip select pin being given by the parameters port and pin; communication port and pins are designated by the hardware SPI settings for the respective MCU.Function returns 0 if MMC card is present and successfully initialized, otherwise returns 1.Mmc_Init needs to be called before using other functions of this library.



Requires



Spi_Init_Advanced(MASTER_OSC_DIV16, DATA_SAMPLE_MIDDLE, CLK_IDLE_LOW, LOW_2_HIGH); must be called before calling Mmc_Init.



Example



Spi_Init_Advanced(MASTER_OSC_DIV16, DATA_SAMPLE_MIDDLE, CLK_IDLE_LOW, LOW_2_HIGH); while (Mmc_Init(&PORTC,2)) ; // Loop until MMC is initialized



Mmc_Read_Sector Prototype



unsigned short Mmc_Read_Sector(unsigned long sector, char *data);



Returns



Returns 0 if read was successful, or 1 if an error occurred.



Description



Function reads one sector (512 bytes) from MMC card at sector address sector. Read data is stored in the array data. Function returns 0 if read was successful, or 1 if an error occurred.



Requires



Library needs to be initialized, see Mmc_Init.



Example



error = Mmc_Read_Sector(sector, data);



Mmc_Write_Sector Prototype



unsigned short Mmc_Write_Sector(unsigned long sector,char *data);



Returns



Returns 0 if write was successful; returns 1 if there was an error in sending write command; returns 2 if there was an error in writing.



Description



Function writes 512 bytes of data to MMC card at sector address sector. Function returns 0 if write was successful, or 1 if there was an error in sending write command, or 2 if there was an error in writing.



Requires



Library needs to be initialized, see Mmc_Init.



Example



error = Mmc_Write_Sector(sector, data);
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Mmc_Read_Cid Prototype



unsigned short Mmc_Read_Cid(unsigned short *data_for_registers);



Returns



Returns 0 if read was successful, or 1 if an error occurred.



Description



Function reads CID register and returns 16 bytes of content into data_for_registers.



Requires



Library needs to be initialized, see Mmc_Init.



Example



error = Mmc_Read_Cid(data);



Mmc_Read_Csd Prototype



unsigned short Mmc_Read_Csd(unsigned short *data_for_registers);



Returns



Returns 0 if read was successful, or 1 if an error occurred.



Description



Function reads CSD register and returns 16 bytes of content into data_for_registers.



Requires



Library needs to be initialized, see Mmc_Init.



Example



error = Mmc_Read_Csd(data);
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Mmc_Fat_Init Prototype



unsigned short Mmc_Fat_Init(unsigned short *port, unsigned short pin);



Returns



Returns 0 if initialization is successful, 1 if boot sector was not found and 255 if card was not detected.



Description



Initializes MMC/SD cards for FAT routines; CS line for communication is given through the port and pin parameters. This function needs to be called before using other functions of MMC FAT library.



Requires



Spi_Init_Advanced(MASTER_OSC_DIV16, DATA_SAMPLE_MIDDLE, CLK_IDLE_LOW, LOW_2_HIGH); must be called before calling Mmc_Fat_Init.



Example



Spi_Init_Advanced(MASTER_OSC_DIV16, DATA_SAMPLE_MIDDLE, CLK_IDLE_LOW, LOW_2_HIGH); // Loop until MMC FAT is initialized at RC2 while (Mmc_Fat_Init(&PORTC, 2)) ;



Mmc_Fat_Assign Prototype



void Mmc_Fat_Assign(char *filename);



Description



This routine designates (“assigns”) the file we’ll be working with. Function looks for the file specified by the filename in the root directory. If the file is found, routine will initialize it by getting its start sector, size, etc. If the file is not found, an empty file will be created with the given name. The filename must be 8 + 3 characters in uppercase.



Requires



Library needs to be initialized; see Mmc_Fat_Init.



Example



// Assign the file "EXAMPLE1.TXT" in the root directory of MMC. // If the file is not found, routine will create one. Mmc_Fat_Assign("EXAMPLE1TXT");
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Mmc_Fat_Reset Prototype



void Mmc_Fat_Reset(unsigned long *size);



Description



Function resets the file pointer (moves it to the start of the file) of the assigned file, so that the file can be read. Parameter size stores the size of the assigned file, in bytes.



Requires



Library needs to be initialized; see Mmc_Fat_Init.



Example



Mmc_Fat_Reset(&filesize);



Mmc_Fat_Rewrite Prototype



void Mmc_Fat_Rewrite(void);



Description



Function resets the file pointer and clears the assigned file, so that new data can be written into the file.



Requires



Library needs to be initialized; see Mmc_Fat_Init.



Example



Mmc_Fat_Rewrite();



Mmc_Fat_Append Prototype



void Mmc_Fat_Append(void);



Description



The function moves the file pointer to the end of the assigned file, so that data can be appended to the file.



Requires



Library needs to be initialized; see Mmc_Fat_Init.



Example



Mmc_Fat_Append();



page MikroElektronika: Development tools - Books - Compilers



289



mikroC mikroC - C Compiler for Microchip PIC microcontrollers



making it simple...



Mmc_Fat_Read Prototype



void Mmc_Fat_Read(unsigned short *data);



Description



Function reads the byte at which the file pointer points to and stores data into parameter data. The file pointer automatically increments with each call of Mmc_Fat_Read.



Requires



File pointer must be initialized; see Mmc_Fat_Reset.



Example



Mmc_Fat_Read(&mydata);



Mmc_Fat_Write Prototype



void Mmc_Fat_Write(char *fdata, unsigned data_len);



Description



Function writes a chunk of data_len bytes (fdata) to the currently assigned file, at the position of the file pointer.



Requires



File pointer must be initialized; see Mmc_Fat_Append or Mmc_Fat_Rewrite.



Example



Mmc_Fat_Write(txt, 21); Mmc_Fat_Write("Hello\nworld", 1);



Mmc_Set_File_Date Prototype



void Mmc_Set_File_Date(unsigned year, char month, char day, char hours, char min, char sec);



Description



Writes system timestamp to a file. Use this routine before each writing to the file; otherwise, file will be appended a random timestamp.



Requires



File pointer must be initialized; see Mmc_Fat_Append or Mmc_Fat_Rewrite.



Example



// April 1st 2005, 18:07:00 Mmc_Set_File_Date(2005, 4, 1, 18, 7, 0);
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Mmc_Fat_Delete Prototype



void Mmc_Fat_Delete();



Description



Deletes file from MMC.



Requires



Ports must be initialized for FAT operations with MMC. See Mmc_Fat_Init. File must be assigned. See Mmc_Fat_Assign.



Example



Mmc_Fat_Delete;



Mmc_Fat_Get_File_Date Prototype



void Mmc_fat_Get_File_Date(unsigned int *year, unsigned short *month, unsigned short *day, unsigned short *hours, unsigned short *mins);



Description



Reads time attributes of file.You can read file year, month, day. hours, mins, seconds.



Requires



Ports must be initialized for FAT operations with MMC. See Mmc_Fat_Init. File must be assigned. See Mmc_Fat_Assign.



Example



Mmc_Fat_Get_File_Date(year, month, day, hours, mins);



Mmc_Fat_Get_File_Size Prototype



unsigned long Mmc_fat_Get_File_Size();



Description



This function returns size of file in bytes.



Requires



Ports must be initialized for FAT operations with MMC. See Mmc_Fat_Init. File must be assigned. See Mmc_Fat_Assign.



Example



Mmc_Fat_Get_File_Size;
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Mmc_Fat_Get_Swap_File Prototype



unsigned long Mmc_Fat_Get_Swap_File(unsigned long sectors_cnt);



Returns



No. of start sector for the newly created swap file, if swap file was created; otherwise, the function returns zero.



Description



This function is used to create a swap file on the MMC/SD media. It accepts as sectors_cnt argument the number of consecutive sectors that user wants the swap file to have. During its execution, the function searches for the available consecutive sectors, their number being specified by the sectors_cnt argument. If there is such space on the media, the swap file named MIKROSWP.SYS is created, and that space is designated (in FAT tables) to it. The attributes of this file are: system, archive and hidden, in order to distinct it from other files. If a file named MIKROSWP.SYS already exists on the media, this function deletes it upon creating the new one. The purpose of the swap file is to make reading and writing to MMC/SD media as fast as possible, by using the Mmc_Read_Sector() and Mmc_Write_Sector() functions directly, without potentially damaging the FAT system. Swap file can be considered as a "window" on the media where user can freely write/read the data, in any way (s)he wants to. Its main purpose in mikroC's library is to be used for fast data acquisition; when the time-critical acquisition has finished, the data can be re-written into a "normal" file, and formatted in the most suitable way.



Requires



Ports must be initialized for FAT operations with MMC. See Mmc_Fat_Init.



Example



//Tries to create a swap file, whose size will be at least 1000 //sectors. //If it succeeds, it sends the No. of start sector over USART void M_Create_Swap_File() { size = Mmc_Fat_Get_Swap_File(1000); if (size) { Usart_Write(0xAA); Usart_Write(Lo(size)); Usart_Write(Hi(size)); Usart_Write(Higher(size)); Usart_Write(Highest(size)); Usart_Write(0xAA); } }//~
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Library Example The following code tests MMC library routines. First, we fill the buffer with 512 “M” characters and write it to sector 56; then we repeat the sequence with character “E” at sector 56. Finally, we read the sectors 55 and 56 to check if the write was successful. unsigned i; unsigned short tmp; unsigned short data[512]; void main() { Usart_Init(9600); Spi_Init_Advanced(MASTER_OSC_DIV16, DATA_SAMPLE_MIDDLE, CLK_IDLE_LOW,LOW_2_HIGH); // Initialize SPI // Wait until MMC is initialized while (Mmc_Init(&PORTC, 2)) ; // Fill the buffer with the 'M' character for (i = 0; i output void DAC_Output(unsigned valueDAC) { char temp; PORTB &= ~(_CHIP_SELECT); temp = (valueDAC >> 8) & 0x0F; temp |= 0x30; Soft_Spi_Write(temp); temp = valueDAC; Soft_Spi_Write(temp); PORTB |= _CHIP_SELECT; }//~



// ClearBit(TRISC,CHIP_SELECT);



voltage (0..Vref)



// // // // //



ClearBit(PORTC,CHIP_SELECT); Prepare hi-byte for transfer It's a 12-bit number, so only lower nibble of high byte is used Prepare lo-byte for transfer



// SetBit(PORTC,CHIP_SELECT);



void main() { InitMain(); DAC_Output(2048); // value = 2048; // while (1) { // if ((Button(&PORTC,0,1,1)==_TRUE) // && (value < 4095)) { value++ ; } else { if ((Button(&PORTC,1,1,1)==_TRUE) && (value > 0)) { value-- ; } } DAC_Output(value); // Delay_ms(100); // } }//~!



When program starts, DAC gives the output in the mid-range Main loop Test button on B0 (increment)



// If RB0 is not active then test // RB1 (decrement)



Perform output Slow down key repeat pace
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Software UART Library mikroC provides library which implements software UART. These routines are hardware independent and can be used with any MCU. You can easily communicate with other devices via RS232 protocol – simply use the functions listed below. Note: This library implements time-based activities, so interrupts need to be disabled when using Soft UART.



Library Routines Soft_Uart_Init Soft_Uart_Read Soft_Uart_Write



Soft_Uart_Init Prototype



void Soft_Uart_Init(unsigned short *port, unsigned short rx, unsigned short tx, unsigned short baud_rate, char inverted);



Description



Initalizes software UART. Parameter port specifies port of MCU on which RX and TX pins are located; parameters rx and tx need to be in range 0–7 and cannot point at the same pin; baud_rate is the desired baud rate. Maximum baud rate depends on PIC’s clock and working conditions. Parameter inverted, if set to non-zero value, indicates inverted logic on output. Soft_Uart_Init needs to be called before using other functions from Soft UART



Library. Example



Soft_Uart_Init(PORTB, 1, 2, 9600, 0);
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Soft_Uart_Read Prototype



unsigned short Soft_Uart_Read(unsigned short *error);



Returns



Returns a received byte.



Description



Function receives a byte via software UART. Parameter error will be zero if the transfer was successful. This is a non-blocking function call, so you should test the error manually (check the example below).



Requires



Soft UART must be initialized and communication established before using this function. See Soft_Uart_Init.



Example



// Here’s a loop which holds until data is received: do data = Soft_Uart_Read(&error); while (error); // Now we can work with it: if (data) {...}



Soft_Uart_Write Prototype



void Soft_Uart_Write(char data);



Description



Function transmits a byte (data) via UART.



Requires



Soft UART must be initialized and communication established before using this function. See Soft_Uart_Init. Be aware that during transmission, software UART is incapable of receiving data – data transfer protocol must be set in such a way to prevent loss of information.



Example



char some_byte = 0x0A; ... Soft_Uart_Write(some_byte);
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Library Example The example demonstrates simple data exchange via software UART. When PIC MCU receives data, it immediately sends the same data back. If PIC is connected to the PC (see the figure below), you can test the example from mikroC terminal for RS232 communication, menu choice Tools > Terminal. unsigned short data = 0, ro = 0; unsigned short *er; void main() { er = &ro; // Init (8 bit, 2400 baud rate, no parity bit, non-inverted logic) Soft_Uart_Init(PORTB, 1, 2, 2400, 0); do { do { data = Soft_Uart_Read(er); } while (*er); Soft_Uart_Write(data); } while (1); }//~!



// Receive data // Send data via UART
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Sound Library mikroC provides a Sound Library which allows you to use sound signalization in your applications. You need a simple piezo speaker (or other hardware) on designated port.



Library Routines Sound_Init Sound_Play



Sound_Init Prototype



void Sound_Init(char *port, char pin);



Description



Prepares hardware for output at specified port and pin. Parameter pin needs to be within range 0–7.



Example



Sound_Init(PORTB, 2);



// Initialize sound on RB2



Sound_Play Prototype



void Sound_Play(char period_div_10, unsigned num_of_periods);



Description



Plays the sound at the specified port and pin (see Sound_Init). Parameter period_div_10 is a sound period given in MCU cycles divided by ten, and generated sound lasts for a specified number of periods (num_of_periods).



Requires



To hear the sound, you need a piezo speaker (or other hardware) on designated port. Also, you must call Sound_Init to prepare hardware for output.



Example



To play sound of 1KHz: T = 1/f = 1ms = 1000 cycles @ 4MHz. This gives us our first parameter: 1000/10 = 100. Play 150 periods like this: Sound_Play(100, 150);
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Library Example The example is a simple demonstration of how to use sound library for playing tones on a piezo speaker. The code can be used with any MCU that has PORTB and ADC on PORTA. Sound frequencies in this example are generated by reading the value from ADC and using the lower byte of the result as base for T (f = 1/T).



int adcValue; void main() { PORTB = 0; TRISB = 0; INTCON = 0; ADCON1 = 0x82; TRISA = 0xFF; Sound_Init(PORTB, 2);



// // // // // //



Clear PORTB PORTB is output Disable all interrupts Configure VDD as Vref, and analog channels PORTA is input Initialize sound on RB2



while (1) { adcValue = ADC_Read(2); Sound_Play(adcValue, 200); }



// Play in loop: // Get lower byte from ADC // Play the sound



}
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SPI Library SPI module is available with a number of PIC MCU models. mikroC provides a library for initializing Slave mode and comfortable work with Master mode. PIC can easily communicate with other devices via SPI: A/D converters, D/A converters, MAX7219, LTC1290, etc. You need PIC MCU with hardware integrated SPI (for example, PIC16F877). Note: Certain PICmicros with two SPI modules, such as P18F8722, require you to specify the module you want to use. Simply append the number 1 or 2 to a Spi. For example, Spi2_Write(); Also, for the sake of backward compabitility with previous compiler versions and easier code management, MCU's with multiple SPI modules have SPI library which is identical to SPI1 (i.e. you can use SPI_Init() instead of SPI1_Init() for SPI operations).



Library Routines Spi_Init Spi_Init_Advanced Spi_Read Spi_Write



Spi_Init Prototype



void Spi_Init(void);



Description



Configures and initializes SPI with default settings. SPI_Init_Advanced or SPI_Init needs to be called before using other functions from SPI Library. Default settings are: Master mode, clock Fosc/4, clock idle state low, data transmitted on low to high edge, and input data sampled at the middle of interval. For custom configuration, use Spi_Init_Advanced.



Requires



You need PIC MCU with hardware integrated SPI.



Example



Spi_Init();
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Spi_Init_Advanced Prototype



void Spi_Init_Advanced(char master, char data_sample, char clock_idle, char transmit_edge);



Description



Configures and initializes SPI. Spi_Init_Advanced or SPI_Init needs to be called before using other functions of SPI Library. Parameter mast_slav determines the work mode for SPI; can have the values: MASTER_OSC_DIV4 MASTER_OSC_DIV16 MASTER_OSC_DIV64 MASTER_TMR2 SLAVE_SS_ENABLE SLAVE_SS_DIS



// // // // // //



Master Master Master Master Master Master



clock=Fosc/4 clock=Fosc/16 clock=Fosc/64 clock source TMR2 Slave select enabled Slave select disabled



The data_sample determines when data is sampled; can have the values: DATA_SAMPLE_MIDDLE // Input data sampled in middle of interval DATA_SAMPLE_END // Input data sampled at the end of interval



Parameter clock_idle determines idle state for clock; can have the following values: CLK_IDLE_HIGH CLK_IDLE_LOW



// Clock idle HIGH // Clock idle LOW



Parameter transmit_edge can have the following values: LOW_2_HIGH HIGH_2_LOW



// Data transmit on low to high edge // Data transmit on high to low edge



Requires



You need PIC MCU with hardware integrated SPI.



Example



This will set SPI to master mode, clock = Fosc/4, data sampled at the middle of interval, clock idle state low and data transmitted at low to high edge: Spi_Init_Advanced(MASTER_OSC_DIV4, DATA_SAMPLE_MIDDLE, CLK_IDLE_LOW, LOW_2_HIGH)
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Spi_Read Prototype



char Spi_Read(char buffer);



Returns



Returns the received data.



Description



Provides clock by sending buffer and receives data at the end of period.



Requires



SPI must be initialized and communication established before using this function. See Spi_Init_Advanced or Spi_Init.



Example



short take, buffer; ... take = Spi_Read(buffer);



Spi_Write Prototype



void Spi_Write(char data);



Description



Writes byte data to SSPBUF, and immediately starts the transmission.



Requires



SPI must be initialized and communication established before using this function. See Spi_Init_Advanced or Spi_Init.



Example



Spi_Write(1);
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Library Example The code demonstrates how to use SPI library functions. Assumed HW configuration is: max7219 (chip select pin) connected to RC1, and SDO, SDI, SCK pins are connected to corresponding pins of max7219.



//------------------- Function Declarations void max7219_init1(); //-------------------------------- F.D. end char i; void main() { Spi_Init(); TRISC &= 0xFD; max7219_init1(); for (i = 1; i 
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